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IBM StoredIQ for Legal V2.0.1 documentation
Welcome to IBM StoredIQ for Legal documentation, where you can find information about how to deploy,
maintain, and use IBM StoredIQ for Legal.

Getting started
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Notices
Deploying and configuring IBM StoredIQ for Legal
System requirements
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Administering StoredIQ for Legal
Managing legal matters with StoredIQ for Legal
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Troubleshooting StoredIQ for Legal
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Information lifecycle governance
Enterprise content management

© Copyright IBM Corporation 2015

Start of change

What's new in StoredIQ for Legal V2.0.1

This topic summarizes the new features in StoredIQ for Legal Version 2.0.1.

New System Administrator and Process Administrator roles replace the original
Administrator role

The Administrator role has been replaced by the System Administrator role with a reduced set of default
privileges (user management and system configuration). The new Process Administrator role has the default
set of privileges to manage users, create templates, administer content settings, and manage matters.
Privileges within the roles can be modified.  Learn more...

New privileges for legal user roles

The System Administrator, Paralegal, Attorney and Data Ops roles now have different default sets of
privileges. These privileges can be modified by an administrator with User Management privileges.  Learn
more...

Attachments
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Files can now be attached to hold notices.  Learn more...

Confirm custodians

Legal users with the Manage Matter privilege can now choose to confirm hold notices on behalf of custodians. 
 Learn more...

Custom roles

An administrator with User Management privileges can now define custom roles, and modify the set of
privileges associated with existing roles.  Learn more...

Custom custodian attributes

A process administrator can now define custom attributes for custodians to be stored as user preferences.
Legal users can then display, hide, or sort these attributes, for instance, while viewing recipients.  Learn
more...

Data requests retain the data locales and data source types that were active at
the time of creation

Data locales and data source types are no longer locked after a legal user creates a data request. A system
administrator can now re-configure data locales and data source types at any time. As a result, new data
boxes will use the new configuration while old data boxes retain the previous configuration. Legal users can
see these changes in the box overview history.  Learn more...

Interviews

A process administrator can now create templates for interview questionnaires in a controllable and
consistent fashion. Attorneys and Paralegals can create a questionnaire, send interview notifications
automatically and repeatedly, and track the responses from the recipients. Recipients can also revise answers
in a questionnaire and resubmit it.  Learn more...

Matter data reports

Legal users with the View Data Requests privilege can now run three types of reports on a matter: Notices As
Sent Report, Matter List Report, and Audit Report.  Learn more...

Message editor enhancements

The StoredIQ for Legal text editor has been enhanced with more rich text functionality.  Learn more...

My notifications

Users can now opt to access all of their hold notices and interviews from one place, the Notifications page,
rather than from each individual e-mail notification.  Learn more...

New ways to search

You can now search for a matter by its Matter ID.
You can now search for a user by Person ID (this attribute name can be customized).
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You can search and filter users by custom attributes.
You can now search and filter users by the notices, interviews, data boxes, or custodian groups that
they are assigned to.

 Learn more...

Reason for an action

When you perform one of the following actions on hold notices or interviews, you must specify a reason in the
message where you confirm the action:

Add a custodian or recipient
Remove a custodian or recipient
Release a custodian or recipient

 Learn more...

Suspend notice

In the Expand Details section of a hold notice, a legal user can now click the Suspend Notice button to
permanently pause the hold notice from sending any further messages to the custodians. By suspending the
notice indefinitely, legal users can replace active notices with new notices that have changes. Note that once a
hold notice is in Suspended state, it cannot be resumed.  Learn more...

System settings

A system administrator can configure various StoredIQ for Legal system settings such as dashboard caching
and reports.  Learn more...

Template enhancements

A process administrator can now create a new template starting from a copy of a preexisting template by
clicking Duplicate next to it. You can also send a preview of the message as an e-mail to yourself or any users
with the View Notices or View Interviews privilege. The notice message interface has been redesigned. 
Learn more...

Parent topic: IBM StoredIQ for Legal V2.0.1 documentation
End of change

Notices

This information was developed for products and services offered in the US. This material might be available
from IBM in other languages. However, you may be required to own a copy of the product or product version in
that language in order to access it.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult
your local IBM representative for information on the products and services currently available in your area.
Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product, program, or service that does
not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to
evaluate and verify the operation of any non-IBM product, program, or service.
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IBM may have patents or pending patent applications covering subject matter described in this document.
The furnishing of this document does not grant you any license to these patents. You can send license
inquiries, in writing, to:
IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US
For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual
Property Department in your country or send inquiries, in writing, to:
Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
Some jurisdictions do not allow disclaimer of express or implied warranties in certain transactions, therefore,
this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made
to the information herein; these changes will be incorporated in new editions of the publication. IBM may
make improvements and/or changes in the product(s) and/or the program(s) described in this publication at
any time without notice.

Any references in this information to non-IBM websites are provided for convenience only and do not in any
manner serve as an endorsement of those websites. The materials at those websites are not part of the
materials for this IBM product and use of those websites is at your own risk.

IBM may use or distribute any of the information you provide in any way it believes appropriate without
incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange
of information between independently created programs and other programs (including this one) and (ii) the
mutual use of the information which has been exchanged, should contact:
IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM
under terms of the IBM Customer Agreement, IBM International Program License Agreement or any
equivalent agreement between us.

The performance data discussed herein is presented as derived under specific operating conditions. Actual
results may vary.

The client examples cited are presented for illustrative purposes only. Actual performance results may vary
depending on specific configurations and operating conditions.
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The performance data and client examples cited are presented for illustrative purposes only. Actual
performance results may vary depending on specific configurations and operating conditions.

Information concerning non-IBM products was obtained from the suppliers of those products, their published
announcements or other publicly available sources. IBM has not tested those products and cannot confirm
the accuracy of performance, compatibility or any other claims related to non-IBMproducts. Questions on the
capabilities of non-IBM products should be addressed to the suppliers of those products.

Statements regarding IBM's future direction or intent are subject to change or withdrawal without notice, and
represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject to change without notice.
Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to change before the
products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate them
as completely as possible, the examples include the names of individuals, companies, brands, and products.
All of these names are fictitious and any similarity to actual people or business enterprises is entirely
coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs in
any form without payment to IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating platform for which the
sample programs are written. These examples have not been thoroughly tested under all conditions. IBM,
therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be liable for any damages arising
out of your use of the sample programs.

© (your company name) (year).
Portions of this code are derived from IBM Corp. Sample Programs.
© Copyright IBM Corp. _enter the year or years_.

Trademarks
Privacy policy considerations

Parent topic: IBM StoredIQ for Legal V2.0.1 documentation

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business Machines
Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of
IBM or other companies. A current list of IBM trademarks is available on the web at "Copyright and trademark
information" at www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks of
Adobe Systems Incorporated in the United States, and/or other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the
United States, other countries, or both.

IBM StoredIQ for Legal 2.0.1 5
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Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its
affiliates.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Other company, product, and service names may be trademarks or service marks of others.

Terms and conditions for product documentation

Permissions for the use of these publications are granted subject to the following terms and conditions.

Applicability

These terms and conditions are in addition to any terms of use for the IBM website.

Personal use

You may reproduce these publications for your personal, noncommercial use provided that all proprietary
notices are preserved. You may not distribute, display or make derivative work of these publications, or any
portion thereof, without the express consent of IBM.

Commercial use

You may reproduce, distribute and display these publications solely within your enterprise provided that all
proprietary notices are preserved. You may not make derivative works of these publications, or reproduce,
distribute or display these publications or any portion thereof outside your enterprise, without the express
consent of IBM.

Rights

Except as expressly granted in this permission, no other permissions, licenses or rights are granted, either
express or implied, to the publications or any information, data, software or other intellectual property
contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its discretion, the use of the
publications is detrimental to its interest or, as determined by IBM, the above instructions are not being
properly followed.

You may not download, export or re-export this information except in full compliance with all applicable laws
and regulations, including all United States export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE PUBLICATIONS. THE PUBLICATIONS ARE
PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING
BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS
FOR A PARTICULAR PURPOSE.

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business Machines
Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of
IBM or other companies. A current list of IBM trademarks is available on the web at "Copyright and trademark
information" at www.ibm.com/legal/copytrade.shtml.
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Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks of
Adobe Systems Incorporated in the United States, and/or other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the
United States, other countries, or both.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its
affiliates.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Other company, product, and service names may be trademarks or service marks of others.

Parent topic: Notices

Privacy policy considerations

IBM Software products, including software as a service solutions, (“Software Offerings”) may use cookies or
other technologies to collect product usage information, to help improve the end user experience, to tailor
interactions with the end user or for other purposes. In many cases no personally identifiable information is
collected by the Software Offerings. Some of our Software Offerings can help enable you to collect personally
identifiable information. If this Software Offering uses cookies to collect personally identifiable information,
specific information about this offering’s use of cookies is set forth below.

Depending upon the configurations deployed, this Software Offering may use session cookies that collect
each user’s name, user name, password and role for purposes of session management, authentication, or
other usage tracking or functional purposes. These cookies cannot be disabled.

If the configurations deployed for this Software Offering provide you as customer the ability to collect
personally identifiable information from end users via cookies and other technologies, you should seek your
own legal advice about any laws applicable to such data collection, including any requirements for notice and
consent.

For more information about the use of various technologies, including cookies, for these purposes, see IBM’s
Privacy Policy at www.ibm.com/privacy and IBM’s Online Privacy Statement at www.ibm.com/privacy/details
the section entitled “Cookies, Web Beacons and Other Technologies” and the “IBM Software Products and
Software-as-a-Service Privacy Statement” at www.ibm.com/software/info/product-privacy.

Parent topic: Notices

IBM StoredIQ for Legal overview

You can use IBM® StoredIQ for Legal to automate your legal hold notification and compliance process, and to
optimize your preservation and collection process.

StoredIQ for Legal provides the following key features to help you manage your legal processes and improve
the communication and workflow between your legal and IT teams:

Legal matter management
Allows you to manage legal matters including matter creation, hold notices, interviews, data
identification, and data collection and preservation. The matters dashboard enables you to see a

IBM StoredIQ for Legal 2.0.1 7

http://www.ibm.com/privacy
http://www.ibm.com/privacy/details
http://www.ibm.com/software/info/product-privacy


complete list of matters, all notices and interviews associated with them, and their data requests and
associated statistics. You can also filter, search, and sort the information in the dashboard.

People management
You can import users from your company's directory server, assign the users specific roles, and create
custodian groups.

Hold notice management
Allows you to create, send, and manage hold notices, including follow-up and reminder notices. You
can also create and maintain a library of notice templates for reuse.

Start of changeInterview management End of change
Start of changeAllows you to create, send, and manage interview questionnaires, and track the

responses from the interviewees. You can also create and maintain a library of interview questionnaire
templates for reuse. End of change

Data request management
Allows you to create and manage requests to identify, collect, and export matter-relevant data.

System requirements
Use the Software Product Compatibility Reports page to generate a report for supported operating
systems, related software, hypervisors, hardware requirements, and detailed system requirements.
You can also get support information related to product translations and product end of service.

Deploying and configuring StoredIQ for Legal

Complete the following steps to deploy and configure StoredIQ for Legal.

Before you deploy and configure StoredIQ for Legal, ensure that you meet all hardware and software
requirements.

Deployment overview
IBM® StoredIQ Platform is a virtual appliance that you deploy and configure in a VMWare virtual host
environment.
Deployment preparation
Conduct the planning activities that apply to your environment.
Deployment tools
IBM StoredIQ for Legal deployment uses the OVF file format and VMWare vSphere Client.
Configuring IBM StoredIQ for Legal
After you deploy IBM StoredIQ for Legal, power on the virtual machine and configure the network
settings.

Deployment overview

IBM® StoredIQ Platform is a virtual appliance that you deploy and configure in a VMWare virtual host
environment.

Software components

The StoredIQ for Legal system consists of a web client and server.

Web client
The web client is the primary interface to the StoredIQ for Legal system. Users run the web
client in a web browser. StoredIQ for Legal administrative users use the web client to administer
the system, and legal users (attorneys and paralegals) use it to create and manage legal matters,
hold notices, and data requests.

8   IBM StoredIQ for Legal 2.0.1



Server
The StoredIQ for Legal server provides the services to support the functions of the web client.

Deployment component

StoredIQ for Legal is a virtual appliance that consists of a single Open Virtualization Format Archive
(OVA) file.

Parent topic: Deploying and configuring StoredIQ for Legal

Deployment preparation

Conduct the planning activities that apply to your environment.

Open Virtual Appliance (OVA) configuration requirements
StoredIQ for Legal is deployed as a virtual appliance and is only supported in VMware environments.
You must have a virtual infrastructure that meets the StoredIQ for Legal hardware requirements.
Virtual machine provisioning prerequisites
Before you deploy IBM® StoredIQ for Legal, verify that you meet these prerequisites.

Parent topic: Deploying and configuring StoredIQ for Legal

Open Virtual Appliance (OVA) configuration requirements

StoredIQ for Legal is deployed as a virtual appliance and is only supported in VMware environments. You must
have a virtual infrastructure that meets the StoredIQ for Legal hardware requirements.

Virtual machine minimum specifications

vCPU: 4
Memory: 10 GB

Start of changeStorage: 200 GB End of change

Parent topic: Deployment preparation

Virtual machine provisioning prerequisites

Before you deploy IBM® StoredIQ for Legal, verify that you meet these prerequisites.

At least one physical server with sufficient processor, RAM, and hard disk configuration for the planned
management project.
VMWare ESX or VMWare ESXi on CD/DVD or USB drive.
IP addresses, cables, and physical switch ports for the VMWare ESX or VMWare ESXi interface and one
virtual machine.
Network connectivity that is enabled from the following locations:

Ports 9443, 9043, 443, and 22 from the administrative workstation to the virtual machine IP
address
Outbound connections: In all cases, the port is configurable in the application user interface, and
can be changed according to environment requirements.
LDAP: User information will come from an LDAP server supplied by you. Specific outbound ports
can be configured in StoredIQ for Legal.

IBM StoredIQ for Legal 2.0.1 9



SMTP: Email notifications to people are sent using an SMTP server supplied by you. Specific
outbound ports can be configured in StoredIQ for Legal.
IBM StoredIQ: If the data request features in StoredIQ for Legal are used, then the ports from
the IBM StoredIQ configuration must be configured.

Parent topic: Deployment preparation

Deployment tools

IBM® StoredIQ for Legal deployment uses the OVF file format and VMWare vSphere Client.

Open Virtualization Format (OVF)
An OVF is a file format that allows for the exchange of virtual appliances across products and platforms.
Deploying the virtual appliance
Use VMWare vSphere Client to deploy the virtual appliance to a VMWare ESX or VMWare vCenter
server. One OVA file needs to be deployed.

Parent topic: Deploying and configuring StoredIQ for Legal

Open Virtualization Format (OVF)

An OVF is a file format that allows for the exchange of virtual appliances across products and platforms.

The OVF format offers these advantages:

OVF files are compressed, allowing for faster downloads.
The VMWare vSphere Client validates an OVF file before it imports it and ensures that it is compatible
with the intended destination server. If the virtual appliance is incompatible with the selected host, it
cannot be imported, and an error message is displayed.
An OVF can encapsulate multitiered applications and more than one virtual machine.

The basic differences between OVFs and OVAs are as follows:

An OVF is a collection of items in a single folder. Most commonly, it is a description file (.ovf), a manifest
file (.mf), and virtual machine state files (*.vhd or *.vmdk).
An OVA is a single file. The OVA is the OVF folder contents that are all compressed into a single file. The
OVA is used when you want to take an OVF and share it, or give it as a download. The OVA needs to be
opened into the OVF before it can be used, although it is not necessary when you use VMware. This
step is automatically conducted during import. Both OVF and OVA files can be directly imported into
VMWare vCenter and VMWare vSphere.

Parent topic: Deployment tools

Deploying the virtual appliance

Use VMWare vSphere Client to deploy the virtual appliance to a VMWare ESX or VMWare vCenter server. One
OVA file needs to be deployed.

Before you begin

Ensure that all prerequisites for the deployment are met before you start this task.
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About this task

Procedure

To deploy the virtual appliance:

1. Connect to the VMWare ESX server or VMWare vCenter server with the VMWare vSphere client.
2. From the File menu, select Deploy OVF Template. The Deploy OVF Template wizard is displayed.
3. In the Deploy OVF Template wizard, complete the following steps:

a. In the Source page, click Browse, and then browse to and select the appropriate OVA file. Click
Next.

b. In the OVF Template Details page, review the OVF template details. These storage requirements
are critical and are used to select a data store during deployment. Click Next.

c. In the Name and Location page, enter the host name of the virtual machine and select the
inventory folder in which to put the virtual machine. Click Next.
Important: The host name must be unique within the inventory folder. Ensure that you select the
correct folder in which to put the virtual machine.

Also, the host name is used when you do the virtual machine network configuration and in the
web address (URL) that is used by all users to connect to StoredIQ for Legal. Carefully choose
the host name now, as it is frequently used.

d. In the Host / Cluster page, enter the name of the VMWare host or cluster on which the template
is deployed. Click Next.

e. In the Resource Pool page, select the resource pool within which to deploy the template. Click
Next.

f. In the Storage page, select the destination storage for the virtual machine files. Click Next.
g. In the Disk Format page, select the disk format of the virtual machine. Click Next.

Tip: Selection of the Thin Provision option saves disk space, but can negatively affect
performance. If disk usage is not a concern, select Thick Provision Lazy Zeroed.

h. In the Network Mapping page, map the networks that are used in this OVF template to networks
in your inventory. Click Next.

i. In the Ready to Complete page, review the deployment settings and ensure that they are
correct. If any settings are incorrect, click Back to the appropriate settings page, correct the
settings, and click Next to the Ready To Complete page.
Tip: Select the Power on after deployment check box to power on the virtual machine after
deployment is complete.

j. Click Finish to complete deployment of the OVF template.
A window is displayed that shows that deployment is in progress and the deployment status. When the
deployment completes, the window title changes to Deployment Completed Successfully.

Parent topic: Deployment tools

Configuring IBM StoredIQ for Legal

After you deploy IBM® StoredIQ for Legal, power on the virtual machine and configure the network settings.

Before you begin

If you are assigning a static IP address to your virtual machine, know the static IP address of your
virtual machine before you complete this configuration task. If you do not know the IP address, contact
your VMWare system administrator to get it.

IBM StoredIQ for Legal 2.0.1 11



You cannot use an IP address for more than one virtual machine.

Procedure

To configure the network settings:

1. In VMWare vSphere Client, select the virtual machine that you deployed and right-click.
2. Click Open Console to start the virtual machine console.
3. Within the EULA screen, select I Agree to accept the license agreement, and press Enter.
4. Within the IBM EULA screen, select I Agree to accept the IBM license agreement, and press Enter.
5. Enter the new root password in the prompt and confirm it.

Important: Record the root password for future reference. You need the root password later to log in to
the VM from a console window.

6. Start of changeEnter the password for the bootstrap ilgadmin administrative account at the
prompt, and then retype it to confirm.
Important: This password can be changed at a later time by running the
/usr/local/sbin/create_ilgadmin.sh script and then restarting the VM to propagate the change.

End of change
7. In the console window, select either Static IP or Obtain IP via DHCP.

If you select the Static IP option, complete the following fields to configure the static address:
a. Gather this information to complete the static IP configuration for this system: Host

name, IP Address, Netmask, Gateway, and Primary DNS Host.
b. In the Hostname field, enter the fully qualified host name and press Enter.
c. In the IP Address field, enter the IPv4 address and press Enter.
d. In the Netmask field, enter the netmask for the assigned IP address and press Enter.
e. In the Gateway field, enter the IP address of the default gateway for the IP subnet and

then Enter.
f. In the Primary DNS Host field, enter the IP address for the domain name server and press

Enter.
If you select the Obtain IP via DHCP option, complete the following fields:

a. Gather the host name information to complete the DHCP IP configuration for the system.
b. Select Hostname and enter a fully qualified host name.

8. Select Restart network services.
9. Select Next. The network services of the virtual machine are restarted.

Attention: Depending on the performance of your virtual infrastructure, this process can be lengthy,
taking from just minutes to multiple hours. Be patient.

10. At the login prompt, type root and press Enter.
11. Type the root password and press Enter.

You are logged in to the StoredIQ for Legal virtual machine as the root user in a Linux console window.

12. Verify that you can log in to the StoredIQ for Legal server with the StoredIQ for Legal web client.
a. Open a web browser on a host that has network access to the StoredIQ for Legal server

machine.
b. In the browser address field, enter a web address of the form

https://siqserver/navigator

where siqserver is to be replaced by either the fully qualified host name or IP address of the
StoredIQ for Legal server machine. Push the Enter key.
Important: All StoredIQ for Legal users will use this web address to log in to StoredIQ for Legal.

The result is that the StoredIQ for Legal web client sign-in page is loaded.
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c. Enter the login ID and password of the StoredIQ for Legal administrative user in the provided
fields and click Log In to log in to the system. Start of changeThe default login ID of the
administrative user is ilgadmin and the password is what you entered during the initial account
configuration for this user. End of change On successful login, the Administration page is
displayed.

13. If you need to reconfigure the virtual machine, you can run the following applications from the console
window:

Task Script command
Network configuration /siq/bin/netcfg

SSL certificate configuration /siq/bin/cert_install

Change system administrator password for the
first time you boot the VM

Start of change
/usr/local/sbin/create_ilgadmin

End of change

Change system administrator password /siq/bin/change_ilgadmin_password

Logging configuration /siq/bin/logs

Reset authentication /siq/bin/remove_secdom

Installing and removing custom SSL certificates
IBM StoredIQ for Legal is already configured with self-signed certificates that are used with SSL
connections. However, you can install your own certificates, either self-signed or from a certificate
authority (CA), to be used instead of the preconfigured certificates.

Parent topic: Deploying and configuring StoredIQ for Legal
Related reference:

StoredIQ for Legal console tools

Administering your StoredIQ for Legal system

To get StoredIQ for Legal ready for your users, there are several system administration tasks that you must
complete. There are also various ongoing tasks that you might need to complete to ensure that StoredIQ for
Legal is running efficiently and that it meets your business requirements.

Ingesting users from a directory server
A system administrator must configure the directory server settings and ingest users into IBM®
StoredIQ for Legal to populate the list of custodians and assign user roles.
Configuring the email server
The IBM StoredIQ for Legal email server is used for sending emails regarding a legal matter to the legal
and administrative users. These emails typically contain hold notices, links to interviews, alerts, and
reminders. You must configure the email server and specify the interval at which the emails are to be
sent.
Configuring the IBM StoredIQ server connection
A system administrator must configure the IBM StoredIQ server connection so that IBM StoredIQ for
Legal can connect to it.
Configuring system settings
A system administrator can configure various StoredIQ for Legal system settings. These settings affect
the dashboard and the reports.
Assigning and managing user roles
A role is a function that a user serves within an organization. Each role has a default set of associated
privileges, which allow users to view and modify particular business items and perform certain
functions. To ensure that the right people have the appropriate access to complete their tasks, you
must assign users one or more roles.
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Configuring roles and privileges
An administrator with User Management privileges can customize the roles and privileges in StoredIQ
for Legal.
Creating a test user
A system administrator can create test users in StoredIQ for Legal by using the web client.
Managing the people in your company and creating groups
An administrator with user management privileges can create groups to help the legal staff add
multiple people to a matter, a notice, an interview, or a data request in one step. You can also modify
the attributes of a person and assign a manager to a person.
StoredIQ for Legal console tools
You can use the following StoredIQ for Legal console tools to reconfigure the virtual machine.
Backing up your StoredIQ for Legal system
You can back up and restore your StoredIQ for Legal databases using the following script.
Troubleshooting StoredIQ for Legal
The following section provides guidance for troubleshooting your StoredIQ for Legal system.

Ingesting users from a directory server

A system administrator must configure the directory server settings and ingest users into IBM® StoredIQ for
Legal to populate the list of custodians and assign user roles.

Before you begin

It is assumed that the directory server:

contains a directory of users in an organization that can be users or custodians in the StoredIQ for Legal
system.
provides its services via the Lightweight Directory Access Protocol (LDAP).

Before you can configure the directory server to ingest users into the system, you must have the following
information:

Directory server host name or IP address
Directory server port number (standard port numbers: LDAP: 389, LDAPS: 636)
Base distinguished name (Base DN)
Bind distinguished name (Bind DN)
Directory server attribute mappings

Procedure

1. Log in to StoredIQ for Legal as a system administrator with the Manage External Servers privilege.
2. From the Admin menu, click Start of changeExternal Servers End of change and then click

Directory Server.
3. In the Server host field, enter the directory server host name or IP address.
4. In the Server port field, enter the port number on which the directory server listens.

Important: The standard LDAP server port number is 389. The standard LDAPS (secure LDAP over TLS
or SSL) server port number is 636.

5. In the Base DN field, enter the distinguished name of the organizational unit from which to get users.
Note that StoredIQ for Legal only supports a single directory tree search to find users. For example, you
cannot find users in separate directory trees by specifying
ou=dept,ou=building,ou=location,o=company or
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ou=dept,ou=city,ou=location,o=company. Instead, you must specify
ou=location,o=company to search both trees.

6. In the Bind DN field, enter the distinguished name of the user who has privileges to connect to the
directory server and perform authentication queries.

7. In the Bind password field, enter the password for the user who is specified in the Bind DN field.
8. In the Filter field, enter the authentication query filter to select the users to be ingested from the

directory server.
Important:

The authentication filter is not a regular LDAP query filter. Instead, it is a filter of the form ( &
(<login_id_attribute>=%v)(<ldap_user_query_filter>) ), where login_id_attribute is
replaced by the directory server user attribute that you enter in the Attribute Mapping section for the 

Start of changeLogin ID End of change custodian attribute.

For (<ldap_user_query_filter>), only objectclass parameters are supported in a user query
filter. For example, a supported entry is &(objectclass=user)(objectclass=person). If you want
to filter users with organization unit (ou) parameters, then you must use the Base DN field instead.

9. For the Case sensitive option, click No to ignore case and Yes to not ignore case. This option applies to
internal authorization only.
Important: Start of changeThis option does not affect the user name and the password that you use
to log in to StoredIQ for Legal. Login information is always case-sensitive. End of change

10. For the SSL connection option, click Yes if the entry in Server port is for LDAPS. Otherwise, click No.
Important: Ensure the Server port entry matches the SSL connection selection. If you click Yes, set
Server port to the port configured for LDAPS. If you click No, set Server port to the port configured for
LDAP.

11. For Start of changeSync frequency End of change, select how often you want to refresh the list of
users who are ingested from the directory server.

After you initially ingest users from the directory server, changes can occur in the directory server.
Typically you will want these changes to be synchronized to StoredIQ for Legal. Use the sync frequency
to determine how often the ingested user data is updated. If you want to sync the data immediately,
click Sync.

Important: You must be logged in as the default system administrative user ilgadmin to change the
sync frequency.

For example, if you want to update the user list every two weeks, click Every 2 weeks.

12. Start of changeMap directory server user attributes to StoredIQ for Legal custodian attributes.

Start of changeIn the Attribute Mapping section, for each StoredIQ for Legal custodian attribute and
its data type, enter the directory server user attribute (LDAP Key) that you want to map to that
custodian attribute. End of change

Start of changeEach unconfirmed attribute mapping displays an alert next to it until you confirm it.
To confirm each attribute mapping, click Preview. A list of attribute mappings and associated directory
server data is displayed. The format of the list is a row with an attribute mapping followed by the set of
data that is returned from the directory server based on the mapping. Use this list to verify that you
created the correct mappings. If you need to change the mappings, edit the LDAP Key values as
necessary and click Reload to see the new mapped user data. If you need to change the directory
server configuration, click Cancel, update your settings, and click Preview again. When you are satisfied
with the mappings, click Confirm to save the changes. End of change

During data preview, data validation occurs to ensure that:
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Custodian attribute types are compatible with LDAP key types.
LDAP keys are valid (they exist).
Required custodian attributes, such as Login ID and Person ID, are mapped to LDAP keys (the
LDAP key fields are not empty).

For any incorrect mappings, error messages are displayed.
Important: Ensure that all required attributes have valid mappings with no errors. Otherwise, the
synchronization with the directory server can fail.
Important: StoredIQ for Legal automatically accepts your directory server's signer certificate if your
directory server uses an SSL connection. The certificate acceptance might result in a few minutes delay
in showing the user data table the first time that you click Preview.
Here is an example mapping of the attributes. This is only an example and is not intended for actual
use.

Table 1. Attribute Mapping example
Attribute Name Data Type LDAP Key
Login ID string sAMAccountName

First Name string givenName

Last Name string sn

Email Address string mail

Department string department

Person ID string empNo

Important: At this point, no directory server data was ingested into the StoredIQ for Legal. To ingest
data, you must complete the next step.

When you complete the configuration and ingest the directory server users into StoredIQ for Legal, the
list of custodians in the Custodians page has the custodian attribute values that are populated with the
mapped directory server user attribute values.

End of change
13. Click Save to save your changes.
14. Click Sync to ingest the directory server user data.

If the directory server settings are valid and a connection is successfully made to the directory server,
the following message is displayed: Synchronization started: Directory server
synchronization is in progress. You will be notified when the sync process is
complete. When the data ingestion completes, the following message is displayed:
Synchronization complete: Directory server synchronization completed with
<number> people ingested from the directory server. Verify People.

Important: If you restart the StoredIQ for Legal server before you see the message that says the sync
process completed, you will need to click Sync to ingest the remaining users. Otherwise, if you selected
a sync frequency other than None, the remaining users will be ingested after the sync frequency time
period passes.

15. Restart the StoredIQ for Legal server.

You must restart the StoredIQ for Legal server in order to enable the ingested users to log in to
StoredIQ for Legal. Otherwise, the login IDs and passwords of the ingested users will not be
recognized.

Important:

Problems can occur with the directory server that prevent login by both the administrative user and
ingested users. If the StoredIQ for Legal administrative user cannot log in after you restart the StoredIQ
for Legal server, then you might need to change the StoredIQ for Legal server to use default
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authentication so that the administrative user can log in while you fix the directory server problems.
See the troubleshooting topic "Login fails due to LDAP referral errors".

16. If you want to synchronize the data with the directory server immediately without waiting for the sync
frequency time period to pass, click Sync.

When the synchronization completes, the following message is displayed: Synchronization
complete: Directory server synchronization completed with <number> people
ingested from the directory server. Verify People.

Parent topic: Administering your StoredIQ for Legal system

Configuring the email server

Start of changeThe IBM® StoredIQ for Legal email server is used for sending emails regarding a legal matter
to the legal and administrative users. These emails typically contain hold notices, links to interviews, alerts,
and reminders. You must configure the email server and specify the interval at which the emails are to be
sent. End of change

Before you begin

Ensure that the email server provides its services with the Simple Mail Transfer Protocol (SMTP).

Before you can configure the email server, you must have the following information:

SMTP server host name or IP address
SMTP server port number: 25 (SMTP or SMTP with STARTTLS default), 465 (SMTPS, secured with TLS
or SSL)
SMTP user name - user who the email server authorizes to send email
SMTP password - password of user who the email server authorizes to send email

Start of changeFrom address - email address that identifies the email sender End of change
Start of changeRespond to address - email address that receives the reply to an email
End of change
Start of changeBase confirmation address - base URL that includes host name and, optionally, port

number; it is used to create the links that are included in an email End of change

Procedure

1. Log in to StoredIQ for Legal as a system administrator with the Manage External Servers privilege.
2. From the Admin menu, click Start of changeExternal Servers End of change and then click Email

Server.
3. In the SMTP server field, enter the email server host name or IP address.
4. In the SMTP port field, enter the port number on which the email server listens.

By default, the field is set to 25, which is the standard SMTP or STARTTLS with SMTP server port
number.

5. For SSL connection, select one of the following options:
Option Description

SMTP with STARTTLS Secured with TLS/SSL, uses well-known port 25
SMTPS Secured with TLS/SSL, uses well-known port 465
No Unsecured, uses well-known port 25
Important: Ensure the SMTP port entry matches the SSL connection selection.
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6. For the Need authentication field, select Yes if the email server requires a user name and password to
send emails.

If you select Yes, enter the SMTP user name and password in the provided fields.

7. Start of changeIn the From address field, enter the email address that identifies the email sender.
End of change

8. Start of changeIn the Respond to address field, enter the email address that is to receive the reply to
an email. End of change

9. Start of changeIn the Base confirmation address field, enter the base URL that is used to create the
links that are included in the emails. Specify the host name or IP address of either the StoredIQ for
Legal server or a proxy server that routes requests to the StoredIQ for Legal server. If necessary, also
include the port number. End of change

Start of changeThe links allow the legal user to confirm the receipt of a hold notice or to access an
interview, for example. End of change

An example entry is https://ilgserver.com.
10. Start of changeFor Schedule manager, specify the interval at which the email server is to send the

emails.

For example, if you want the emails to be sent every 15 minutes, select 15min. If you want the emails
to be sent immediately, click Send Now.

End of change
11. Click Save to save all of the entries and selections you made and connect to the email server.

If the email server settings are valid and a connection is successfully made to the email server, a pop-
up message is displayed with the caption Email server connected.

Parent topic: Administering your StoredIQ for Legal system

Configuring the IBM StoredIQ server connection

A system administrator must configure the IBM® StoredIQ server connection so that IBM StoredIQ for Legal
can connect to it.

Before you begin

You must have a working IBM StoredIQ system that is installed and network-accessible to StoredIQ for Legal.

You must have the following information:

IBM StoredIQ server host name or IP address.
User name and password of an IBM StoredIQ system user with role SDK User.

Procedure

1. Log in to StoredIQ for Legal as a system administrator with the Manage External Servers privilege.
2. From the Admin menu, click Start of changeExternal Servers End of change and then click

StoredIQ Server.
3. For the Enable StoredIQ option, select Yes
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If you want to disable the connection to the IBM StoredIQ server, select No, click Save, and skip the
remaining steps. For this change to take effect, you must restart StoredIQ for Legal.

4. In the Server host field, enter the host name or IP address of the IBM StoredIQ server. An example
entry is siqserver.mycompany.com

5. In the Username and Password fields, enter the user name and password of the IBM StoredIQ system
user with role SDK User.

6. Click Save to save all of the entries and selections you made and connect to the IBM StoredIQ server.

If the entries and selections you made are valid and a connection is successfully made to the IBM
StoredIQ server, a pop-up message is displayed with the caption StoredIQ Server Connected!

Parent topic: Administering your StoredIQ for Legal system
Start of change

Configuring system settings

A system administrator can configure various StoredIQ for Legal system settings. These settings affect the
dashboard and the reports.

Before you begin

The administrator must have the privilege to manage external servers.

Procedure

To configure the system settings, complete the following steps:

1. Log in to the StoredIQ for Legal web client as a system administrator.
2. Click Admin in the main menu and then click System Settings.
3. In the System Settings window, you can configure the following settings:

Dashboard Configuration

Enable caching
If set to No, you always see the latest metrics when you open the dashboard. However, a
large amount of matters, notices, and interviews increases the response time of the
dashboard.

If set to Yes, the metrics on the dashboard are, by default, updated every 30 minutes.
However, the refresh of the dashboard takes less time than without caching.

Refresh cache immediately
If set to Yes, the dashboard always shows the latest metrics. Use this setting only if you
expect few changes to the matters to avoid an increase in the response time of the
dashboard.

Enable in-memory caching
If set to Yes, the cached metrics are stored in memory, which decreases the response
time of the dashboard. However, if you have a large amount of matters, the response time
might increase again.

Report Configuration

Generate global custodian reports
Specify whether global custodian reports can be created.
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Report retention period
Specify how long the reports are kept before they are deleted. The default is 30 days.

4. Click Save to save the system settings.

Parent topic: Administering your StoredIQ for Legal system
End of change
Start of change

Assigning and managing user roles

A role is a function that a user serves within an organization. Each role has a default set of associated
privileges, which allow users to view and modify particular business items and perform certain functions. To
ensure that the right people have the appropriate access to complete their tasks, you must assign users one
or more roles.

About this task

An administrator with User Management privileges can assign users the following default roles (users can
have more than one role), create a custom role, modify user privileges for the roles, delete a user (if they are
not associated with a matter), or change a user's role (if they are not associated with a matter). Note that
removing users from role management does not remove the record of the people themselves.

Attorney
Users with the Attorney role are responsible for overseeing legal responsibilities and compliance. They
can only view business items and activity in the system, including matters, notices, interviews, and data
boxes.

Paralegal
Users with the Paralegal role are the primary legal users of the product, and can work with business
items in the system. They are typically responsible for creating and managing matters, notices,
interviews, data boxes, and conducting the process around them. They are also usually the point of
contact for custodians, and follow up when custodians do not respond to notices or interviews.

Data Ops
Users with the Data Ops role typically do not log into a StoredIQ for Legal system. They are only needed
to specify reference and contact user information for IBM® StoredIQ. They are only required if you plan
to use Data Box functions. When Paralegal users use Data Boxes to identify, find, and preserve all data
that is relevant to a legal matter, StoredIQ for Legal coordinates collaboration between the Paralegals
working in the StoredIQ for Legal application and the Data Ops users working in the IBM StoredIQ
system. See Requesting matter data for details.
Important: All StoredIQ for Legal Data Ops users must have corresponding users in IBM StoredIQ with
the same login IDs and with the role of Data User.

System Administrator
Users with the System Administrator role can manage persons and configure integrations with other
systems: directory, email, and IBM StoredIQ servers. The default user with the System Administrator
role is ilgadmin. After you use the ilgadmin user to initially set up the system, create new System
Administrator users for routine administration so that their actions can be audited.

Process Administrator
Users with the Process Administrator role understand the domain thoroughly. They create, configure,
and administer the processes for the organization using such legal entities as matter categories, notice
templates, and interview templates.

If you do not assign a role to a user, the user has custodian privileges. Custodians have the minimum access
required to respond to notices and interviews.
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Procedure

To assign and manage user roles, complete the following steps:

1. Log in to the StoredIQ for Legal web client as an administrator with User Management privileges.
2. From the Admin menu, click Start of changeUser Management End of change and then click 

Start of changeUser Information End of change.
3. Assign roles to a group of users by clicking the Assign Roles button and completing the required

information. For more information, see Ingesting users from a directory server. You can assign roles to
individual users as well.

4. Optional: You can create test users by clicking the Add User button. The Add User button is for non-
production environments only, used to demonstrate users on a system without requiring a directory
server. See Creating a test user for details.

Parent topic: Administering your StoredIQ for Legal system
End of change
Start of change

Configuring roles and privileges

An administrator with User Management privileges can customize the roles and privileges in StoredIQ for
Legal.

About this task

StoredIQ for Legal provides default roles with privileges already assigned to them. An administrator with User
Management privileges can either configure the privileges of existing roles, or create new roles and assign
privileges to them.

Procedure

To configure roles and privileges, complete the following steps:

1. Log in to the StoredIQ for Legal web client as an administrator with User Management privileges.
2. From the Admin menu, click User Management and then click Role and Privileges.
3. In the Role and Privileges window, click the Edit Role icon to modify the privileges for that role. See

Default role privileges for a list of privileges and their defaults.
4. To create a new role, click New Role, type a Role Name, and select a Type. Checkmark each Privilege

that you want to assign. Click the Create button.

What to do next

You can modify and create roles at any time. You can also delete roles by clicking the Delete Role icon next to
the role.

Default role privileges
Users with the roles of System Administrator, Process Administrator, Attorney, Data Ops and Paralegal
have privileges for specific areas and actions by default. An administrator with User Management
privileges can add or remove these privileges, or create a custom role.

Parent topic: Administering your StoredIQ for Legal system
End of change
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Creating a test user

A system administrator can create test users in StoredIQ for Legal by using the web client.

About this task

Before you put StoredIQ for Legal into production, you might need to create test users in a test or demo non-
production system.

To create a user for a non-production environment:

Procedure

1. Log in to the StoredIQ for Legal web client as an administrator with User Management privileges.
2. Start of changeFrom the Admin menu, click User Management and then click User Information.

End of change
3. Click Add User.
4. In the Start of changeAdd User End of change window, fill in the fields. Start of changeLogin ID

End of change, First Name, Last Name are mandatory.
Restriction: The Start of changeLogin ID End of change must comply with the following rules:

Only letters (a-z, A-Z), numerals (0-9), and the underscore character ( _ ) can be used.
The login ID must be unique.
The length must be 60 characters or less. Recommendation: Keep the length less than 20
characters to avoid display problems.
The login ID cannot start with sql, sys, or a numeral.
The login ID cannot be ilgadmin, administrator, admin, user, guest, public, local, or
any SQL reserved word.
To prevent naming conflicts with LDAP users, adopt a naming convention for test users, such as
test_paralegal_1, test_attorney_1, test_dataops_1, test_administrator_1, or
test_custodian_1. Note that the password of test IDs cannot be changed, and defaults to the
login ID.

The rules are enforced at login time, not at the time that you add a user. If the login ID does not comply
with the rules, the user might not be able to log in.

5. Optional: Specify an email address for the user.
6. Select a role.
7. Click Add.

Parent topic: Administering your StoredIQ for Legal system
Start of change

Managing the people in your company and creating groups

An administrator with user management privileges can create groups to help the legal staff add multiple
people to a matter, a notice, an interview, or a data request in one step. You can also modify the attributes of a
person and assign a manager to a person.

Procedure

To manage the people, complete the following actions:
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1. Log in to StoredIQ for Legal as an administrator with user-management privileges.
2. Click People in the main menu.

On the People page, you can complete the following actions:

Create a group and set its name, description, and the list of people who are members of the
group.
Modify the name and description of an existing group.
Add people to, or remove people from, an existing group.
Delete a group.
Modify the attributes of a person.

If an attribute is mapped to an LDAP key, you must unmap it before you can modify it. To unmap
it, go to Admin > External Servers > Directory Server, remove the LDAP key for the appropriate
attribute, confirm your change in the preview, and then save and synchronize your change.

Assign a manager to a person.

Parent topic: Administering your StoredIQ for Legal system
End of change

StoredIQ for Legal console tools

You can use the following StoredIQ for Legal console tools to reconfigure the virtual machine.

Network configuration

The /siq/bin/netcfg script reruns the network setup for StoredIQ for Legal, for example, to specify your
hostname and type of IP. See Configuring IBM® StoredIQ for Legal for details.

SSL certificate configuration

The /siq/bin/cert_install script can remove and install SSL certificates. See Installing and removing
custom SSL certificates for details.

Change system administrator password

You can change the password for the ilgadmin login ID using the following script.

To run the script, issue the following command: /siq/bin/change_ilgadmin_password

Reset authentication

If an LDAP user or system administrator cannot log into StoredIQ for Legal after the Directory Server has been
configured and the server restarted, and both the liger.log and WebSphere® Application Server logs show
LDAP partial results or referral errors (as in nested host not found exceptions), then the directory server might
not be configured properly for referrals and the authentication configuration might be corrupted.

To delete restored authentication back to default settings, log into StoredIQ for Legal, run
/siq/bin/remove_secdom and then restart the StoredIQ for Legal server. Afterward the default
administrative account will be able to log in again and you can use this account to reconfigure your directory
server once the referral issues have been resolved.
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Parent topic: Administering your StoredIQ for Legal system

Backing up your StoredIQ for Legal system

You can back up and restore your StoredIQ for Legal databases using the following script.

About this task

The script performs the following tasks automatically:

1. Locates the volume where the StoredIQ for Legal databases exist.
2. Shuts down the StoredIQ for Legal system.
3. Copies all StoredIQ for Legal database files.
4. Restores all StoredIQ for Legal services.

Procedure

1. To back up your StoredIQ for Legal system into a backup file, for example,
data_2015.Apr.06_22.08.45.dat, issue the following command: /siq/bin/backup create
data_2015.Apr.06_22.08.45.dat The filename is optional, and a -folder option can be used to
specify where to put the backup file.

2. To list your available backups, issue the following command: /siq/bin/backup list.
3. To restore your StoredIQ for Legal system, issue the following command: /siq/bin/backup restore
data_2015.Apr.06_22.08.45.dat -p password1 where password1 represents your system
administration password.

Parent topic: Administering your StoredIQ for Legal system

Troubleshooting StoredIQ for Legal

Start of change The following section provides guidance for troubleshooting your StoredIQ for Legal
system. If you do not find a solution to your problem, contact IBM® Support. End of change

Login fails due to an incorrect login ID
When creating local users, administrators must self-enforce the StoredIQ for Legal restrictions for login
IDs. Otherwise, the local user will not be able to login successfully.
Login fails due to LDAP referral errors
If an LDAP user or administrator cannot log into StoredIQ for Legal due to LDAP partial results or
referral errors, you can run a script to reset the LDAP authentication.
Login fails because a connection to the web client could not be established
Your login can stop working for a variety of reasons.
The email server does not send out any emails
As system administrator, you want to send out all available emails immediately. However, an error
occurs.

Parent topic: Administering your StoredIQ for Legal system

Login fails due to an incorrect login ID
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When creating local users, administrators must self-enforce the StoredIQ for Legal restrictions for login IDs.
Otherwise, the local user will not be able to login successfully.

Symptoms

Login into StoredIQ for Legal fails because a login ID exceeds the maximum length or contains characters or
keywords that are not allowed.

Causes

StoredIQ for Legal does not automatically block administrators from creating local users that violate the login
ID restrictions.

Resolving the problem

When creating local users, administrators must ensure that they enforce the StoredIQ for Legal restrictions for
login IDs. See Creating a test user for the restrictions.

Parent topic: Troubleshooting StoredIQ for Legal

Login fails due to LDAP referral errors

If an LDAP user or administrator cannot log into StoredIQ for Legal due to LDAP partial results or referral
errors, you can run a script to reset the LDAP authentication.

Symptoms

Login into StoredIQ for Legal fails. Both the liger.log and WebSphere® Application Server logs show nested
host not found exceptions.

Causes

The LDAP server might not be misconfigured for referrals, or the security domain might be corrupted.

Resolving the problem

Delete your configured security domain and fix LDAP by completing the following steps:

1. Log into StoredIQ for Legal.
2. Run the /siq/bin/remove_secdom.sh script.
3. Restart the StoredIQ for Legal server.

Afterward all LDAP users should be able to log in again.
Parent topic: Troubleshooting StoredIQ for Legal

Login fails because a connection to the web client could not be
established

Your login can stop working for a variety of reasons.
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Symptoms

Login into StoredIQ for Legal succeeded previously, but now fails because A connection to the web
client cannot be established using the following URL.

Causes

You logged out while the login page was still loaded.
Your login session timed out due to lack of activity.
You changed your LDAP password and your web browser has the old password saved.
You lost your network connection.
Your power went out.
The StoredIQ for Legal server shut down.

Resolving the problem

Close your sessions, check your connection to the StoredIQ for Legal server, and retry the login.
Parent topic: Troubleshooting StoredIQ for Legal

Start of change

The email server does not send out any emails

As system administrator, you want to send out all available emails immediately. However, an error occurs.

Symptoms

After you click Send Now on the Email Server page, you get the following message:

An error occurred when the email server tried to send the emails.

No emails are sent out.

Resolving the problem

Complete these steps:

1. Check the liger.log file for the cause of the problem.
2. If the log file does not help solve the problem, restart StoredIQ for Legal.
3. Log in again. Go to Admin > External Servers > Email Server and then click Send Now.
4. If you receive the message that all emails were sent out successfully, verify that the emails were sent.

If no emails were sent or if you receive an error again, contact IBM® Support.

Parent topic: Troubleshooting StoredIQ for Legal
End of change

Administering your StoredIQ for Legal processes

To get StoredIQ for Legal ready for your users, there are several process administration tasks that you must
complete. There are also various ongoing tasks that you might need to complete to ensure that StoredIQ for
Legal is running efficiently and that it meets your business requirements.
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Creating and configuring notice templates
Notice templates define and standardize how a hold notice is processed. Users can create hold notices
only after a process administrator creates notice templates.
Creating and configuring interview templates
Interview templates define and standardize how interview questionnaires are processed and are
required to create interviews. The process administrator creates interview templates.
Creating, updating, and deleting matter categories
To improve matter management, you have the option of creating legal categories. For example, you
might create categories for IP Related, Internal, Financial, Regulatory, and Securities.
Configuring hold notice settings
You can customize the confirmation page and confirmation link instructions for the legal hold notices
that IBM® StoredIQ for Legal legal users send.
Configuring data source types for requests
You must configure the list of data source types in your enterprise so that the legal staff can select the
locales when creating requests. A process administrator can assign source types to data locales, add
locales, modify locales, and remove locales.
Customizing custodian attributes
Custodian attributes define information about each custodian, for example, login ID, first and last
name, e-mail address, manager, and department. You can define custom attributes for your system.

Creating and configuring notice templates

Notice templates define and standardize how a hold notice is processed. Users can create hold notices only
after a process administrator creates notice templates.

About this task

A hold notice notifies custodians of their obligations about a hold. Legal users, typically paralegals, select
matters on the Matters page and create hold notices. When users create hold notices, they must select notice
templates from the notice templates library.

Start of changeFrom the Templates page, you can activate draft notice templates, deactivate active
templates, delete draft templates, duplicate templates, and preview templates. End of change

Attention:

You cannot restore a draft template after you delete it. Delete is permanent.
Start of changeA template can be deleted only before you activate it for the first time.
End of change

Procedure

To create and configure a notice template:

1. Log in to the StoredIQ for Legal web client as a process administrator and click Templates.
2. To create a notice template, click New Template. Start of changeAlternatively, you can create a new

notice template starting from a copy of a preexisting template by clicking Duplicate next to it.
End of change

a. Required: In the Template Name field, enter the name of the template. The notice template
name must be unique from any other template name (including interview template names).
Tip: Assign template names that are meaningful to the users who are responsible for creating
legal notices so that they know which templates to select.
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b. Optional: In the Description field, enter a brief description of the template.

The description is displayed only on the notice Template Details page and is not displayed to
legal users who use the template.

c. Required: Start of changeIn the Type menu, select Notice Template. End of change
d. Click Create.

The Template Creation page is displayed in which you configure the notice template.

3. Configure the notice template. For detailed information about configuring a template notice, see
Modifying notice templates

Modifying notice templates
A notice template defines how a notice is processed. It contains at least the initial notice and,
optionally, follow-up messages, and reminder notices.
Modifying the template for the initial notice
An initial notice is the first hold notice that custodians receive for a particular preservation obligation. It
can optionally ask them to confirm receipt of the hold notice. This template must be created and active
before legal users can begin creating hold notices.
Modifying the template for the follow-up message on the initial notice
Follow-up messages are sent to custodians who did not respond to the initial notice. The custodians
are asked to confirm receipt of the initial notice.
Modifying the template for the reminder notice
Reminder notices refresh the initial notice, and are sent to all custodians whether they responded to
the initial notice or not. The reminder notices require a new confirmation, and have their own follow-up
messages that notify the custodians to confirm.
Modifying the template for the follow-up messages on reminder notices
Follow-up messages are sent to custodians who did not respond to a reminder notice. The custodians
are asked to confirm the receipt of a reminder notice.

Parent topic: Administering your StoredIQ for Legal processes

Modifying notice templates

Start of changeA notice template defines how a notice is processed. It contains at least the initial notice
and, optionally, follow-up messages, and reminder notices. End of change

About this task

Important: Start of changeOnce you activate a template, you cannot edit it again or delete it until you
deactivate it. If a template is still active, then you can only duplicate it. End of change

Procedure

To modify a notice template:

1. Log in to the IBM® StoredIQ for Legal web client as a process administrator and click Templates.

The Templates page is displayed with a list of templates, including their names (as hypertext links),
status (draft, active, inactive) and modification dates.

2. Find the template in the list that you want to modify and click the template name to open the Template
Creation page.

28   IBM StoredIQ for Legal 2.0.1



3. Optional: Start of changeTo modify the template name and the description, click Expand details.
End of change

4. Optional: Start of changeIn the Edit Message Rules and Contents section, select Lock rules in hold
notices that use this template to prevent the legal user from editing the rule set (the legal user will still
be able to edit the message text). End of change

5. Start of changeTo modify the contents of the initial notice, click Initial Notice in the Contents section.
The initial notice is required. See Modifying the template for the initial notice for detailed information
about how to modify the initial notice. End of change

6. Click Save Draft in the title bar to save your changes without activating the template.
7. Start of changeTo modify the contents of the follow-up message on the initial notice, see Modifying

the template for the follow-up message on the initial notice. End of change
8. Start of changeTo modify the contents of the reminder notice, see Modifying the template for the

reminder notice. End of change
9. Start of changeTo modify the contents of the follow-up message on reminder notices, see Modifying

the template for the follow-up messages on reminder notices. End of change
10. Optional: Start of changeClick Preview Template to see what the custodians see. You can also click 

Start of changeSend text message End of change to email a preview of any message to yourself or
any users with the View Notices privilege. End of change

11. After you finish, you have the following additional options in the left pane:
Click Duplicate to duplicate the template.

Start of changeClick Delete to delete the template. A template can be deleted only before it is
activated for the first time. End of change
Click Activate when you are ready to make the template available for use. Then, it can be used to
create hold notices for matters.
Important: Active templates can only be duplicated. To edit an active template, it must be
deactivated first.

Parent topic: Creating and configuring notice templates

Modifying the template for the initial notice

Start of changeAn initial notice is the first hold notice that custodians receive for a particular preservation
obligation. It can optionally ask them to confirm receipt of the hold notice. This template must be created and
active before legal users can begin creating hold notices. End of change

About this task

Important: You can modify notice templates that are in draft state. You cannot modify notice templates that
are in active or inactive states.

Procedure

To modify the template for the initial notice:

1. Start of changeClick Initial Notice. End of change
2. Enter a subject in the Subject field.
3. Modify or enter the contents of the initial notice, including text with different formats and fonts, tables,

and images.
4. Optional: Start of changeTo insert system variables into the content, select them from the System

Variables list. End of change
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The system variables represent dynamic data, such as the name of a custodian or the name of an
attorney for the matter. When a notice is sent that contains system variables in the content, the system
variables are replaced with actual values.

If you want custodians to confirm receipt of the hold notice, you can include a Confirmation Link
variable. This variable automatically inserts a web link that the custodian opens to confirm receipt of
the hold notice. A confirmation link is mandatory if you plan to send out follow-up messages and
reminder notices.

Parent topic: Creating and configuring notice templates

Modifying the template for the follow-up message on the
initial notice

Follow-up messages are sent to custodians who did not respond to the initial notice. The custodians are asked
to confirm receipt of the initial notice.

About this task

Important: You can modify notice templates that are in draft state. You cannot modify notice templates that
are in active or inactive states.

Procedure

To modify the template for the follow-up message on the initial notice:

1. Start of changeIn the Rules section next to Initial notice, select the Require confirmation and follow-
up check box. End of change

2. Configure how often the follow-up message is to be sent.
a. Start of changeFrom the Follow-up frequency list, select the intervals between two follow-up

messages. The first follow-up message is sent based on the send date of the initial notice and
the follow-up frequency. End of change

b. From the Repeat list, select the number of times that the follow-up message is to be sent.
c. If you want to send a message to the manager of the custodian after the final follow-up message

is sent, select Start of changeAllow escalation End of change.
3. Start of changeIn the Contents section, click Follow-Up - Initial Notice. End of change
4. Enter a subject in the Subject field.
5. Modify or enter the contents of the follow-up message, including text with different formats and fonts,

tables, and images.
6. Optional: Start of changeTo insert system variables into the content, select them from the System

Variables list. End of change

The system variables represent dynamic data, such as the name of a custodian or the name of an
attorney for the matter. When a notice is sent that contains system variables in the content, the system
variables are replaced with actual values.

Include at least the Confirmation Link variable so that the custodians can confirm receipt of the hold
notice.

Parent topic: Creating and configuring notice templates
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Modifying the template for the reminder notice

Reminder notices refresh the initial notice, and are sent to all custodians whether they responded to the initial
notice or not. The reminder notices require a new confirmation, and have their own follow-up messages that
notify the custodians to confirm.

About this task

Important: You can modify notice templates that are in draft state. You cannot modify notice templates that
are in active and inactive states.

Procedure

To modify the template for the reminder notice:

1. Start of changeIn the Rules section next to Reminder notice, select the Include reminder check box.
End of change

2. Configure how often the reminder notice is to be sent.
a. From the Follow-up frequency list, select the intervals between two reminder notices.

Important: You must set the frequency number to a value greater than zero in order for the
reminder notice to be sent.

b. In the Repeat field, select the number of times that the reminder notice is to be sent. If you
select Indefinitely, the reminder notice keeps going out until the hold notice is closed.

3. Start of changeConfigure the contents of the reminder notice.
a. In the Contents section, click Reminder Notice.
b. Enter a subject in the Subject field.
c. Modify or enter the contents of the reminder notice, including text with different formats and

fonts, tables, and images.
End of change

4. Optional: Start of changeTo insert system variables into the content, select them from the System
Variables list. End of change

The system variables represent dynamic data, such as the name of a custodian or the name of an
attorney for the matter. When a notice is sent that contains system variables in the content, the system
variables are replaced with actual values.

Include at least the Confirmation Link variable so that the custodians can confirm receipt of the hold
notice.

Parent topic: Creating and configuring notice templates

Modifying the template for the follow-up messages on
reminder notices

Follow-up messages are sent to custodians who did not respond to a reminder notice. The custodians are
asked to confirm the receipt of a reminder notice.

About this task

Important: You can modify notice templates that are in draft state. You cannot modify notice templates that
are in active and inactive states.
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Procedure

To modify the template for the follow-up message on reminder notices:

1. Start of changeIn the Rules section next to Reminder notice, select both the Require confirmation
and follow-up check box. End of change

2. Configure how often the follow-up message is to be sent.
a. Start of changeFrom the Follow-up frequency list, select the intervals between two follow-up

messages. The first follow-up message is sent based on the send date of a reminder notice and
the follow-up frequency.
Important: You must set the frequency number to a value greater than zero in order for the
message to be sent.

End of change
b. In the Repeat field, select the number of times that the follow-up message is to be sent.
c. If you want to send a message to the manager of the custodian after the final follow-up message

is sent, select Start of changeAllow escalation End of change.
3. Start of changeConfigure the contents of the follow-up message.

a. In the Contents section, click Follow-Up - Reminder Notice.
b. Enter a subject in the Subject field.
c. Modify or enter the contents of the follow-up message, including text with different formats and

fonts, tables, and images.
End of change

4. Optional: Start of changeTo insert system variables into the content, select them from the System
Variables list. End of change

The system variables represent dynamic data, such as the name of a custodian or the name of an
attorney for the matter. When a notice is sent that contains system variables in the content, the system
variables are replaced with actual values.

Include at least the Confirmation Link variable so that the custodians can confirm receipt of the hold
notice.

Parent topic: Creating and configuring notice templates
Start of change

Creating and configuring interview templates

Interview templates define and standardize how interview questionnaires are processed and are required to
create interviews. The process administrator creates interview templates.

About this task

During a legal matter, attorneys and paralegals can email an interview questionnaire to gather information
that helps define the nature and scope of the matter. Legal users, typically paralegals, create interview
questionnaires from the Matters page by using the interview templates. When users create a new interview,
they must select an interview template from the interview templates library.

From the Templates page, you can activate draft interview templates, deactivate active templates, delete
draft templates, duplicate templates, and preview templates. Once you activate a template, you cannot edit it
again or delete it until you deactivate it. If a template is still active, then you can only duplicate it.
Attention: You cannot restore a draft template after you delete it. Delete is permanent.
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Procedure

To create and configure an interview template:

1. Log in to the StoredIQ for Legal web client as a process administrator and click Templates.
2. To create an interview template, click New Template. Alternatively, you can create a new interview

template starting from a copy of a preexisting template by clicking Duplicate next to it.
a. Required: In the Name field, enter the name of the template. The interview template name must

be unique from any other template name (including notice template names).
Tip: Assign template names that are meaningful to the users who are responsible for creating
interview questionnaires so that they know which templates to select.

b. Optional: In the Description field, enter a brief description of the template.

The description is displayed only on the interview Template Details page and is not displayed to
legal users who use the template.

c. Required: In the Type menu, select Interview Template.
d. Click Create.

The New Template page is displayed in which you configure the interview template.

3. Configure the emails in the interview template. For detailed information about configuring an interview
email, see Modifying interview templates.

4. Configure the questionnaire in the interview template. For detailed information about configuring an
interview questionnaire, see Modifying the template for the questionnaire.

Modifying interview templates
An interview template contains at least the initial interview and, optionally, follow-up messages, and
recurring interviews.
Modifying the template for the initial interview
The initial interview is the first interview that is sent to custodians that notify them of the interview
questionnaire and that provides a link to the questionnaire. This template must be created and active
before legal users can begin creating interview questionnaires.
Modifying the template for the follow-up message on the initial interview
Follow-up messages are sent to recipients who did not respond to the initial interview. They contain a
link to the questionnaire and ask the recipients to complete and return the questionnaire.
Modifying the template for the recurring interview
Recurring interviews refresh the initial interview, and are sent to all recipients whether they responded
to the initial interview or not. The recurring interviews include a link to the questionnaire and have their
own follow-up messages that notify the recipients to complete and return the questionnaire.
Modifying the template for the follow-up messages on recurring interviews
Follow-up messages are sent to those recipients who did not respond to a recurring interview. They
contain a link to the questionnaire and ask the recipients to complete and return the questionnaire
Modifying the template for the questionnaire
The questionnaire contains the questions and possible answers that are to help define the nature and
scope of the matter.

Parent topic: Administering your StoredIQ for Legal processes
End of change
Start of change

Modifying interview templates
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An interview template contains at least the initial interview and, optionally, follow-up messages, and recurring
interviews.

About this task

Important: You can modify interview templates that are in draft state only. You cannot modify interview
templates that are in active and inactive states.

Procedure

To modify interview template messages:

1. Log in to the IBM® StoredIQ for Legal web client as a process administrator and click Templates. The
Templates page is displayed with a list of templates, including their names (as hypertext links), status
(draft, active, inactive) and modification dates.

2. Find the template in the list that you want to modify and click the template name to open the Template
Creation page.

3. Optional: To modify the template name and the description, click Expand details.
4. Click Message.
5. Optional: In the Edit Message Rules and Contents section, select Lock rules in interviews that use this

template to prevent the legal user from editing the rule set (the legal user will still be able to edit the
message text).

6. To modify the initial interview, click Initial Interview in the Contents section. The initial interview is
required. See Modifying the template for the initial interview for detailed information about how to
modify the initial interview.

7. Click Save Draft in the title bar to save your changes without activating the template.
8. To modify the follow-up message on the initial interview, see Modifying the template for the follow-up

message on the initial interview.
9. To modify the recurring interview, see Modifying the template for the recurring interview.

10. To modify the follow-up message on the recurring interview, see Modifying the template for the follow-
up messages on recurring interviews.

11. Optional: Preview the template to see what interview recipients see.
a. Click Preview Template.

A page is displayed in your web browser that shows the interview portal as it appears to
interview recipients after they click View the questionnaire in the interview email that they
receive and log in to the interview portal. The page has two sections that are viewed separately:

b. Click Message to see the interview email.
c. Click Questionnaire to see the interview questionnaire.

You can also click Send test message to send a preview of any message to yourself or any users with
the View Interviews privilege.

12. After you finish, you have the following additional options in the left pane:
Click Duplicate to duplicate the template.

Start of changeClick Delete to delete the template. A template can be deleted only before it is
activated for the first time. End of change
Click Activate when you are ready to make the template available for use. Then, it can be used to
create interviews for matters.
Important: Active templates can only be duplicated. To edit an active template, it must be
deactivated first.

Parent topic: Creating and configuring interview templates
End of change
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Modifying the template for the initial interview

The initial interview is the first interview that is sent to custodians that notify them of the interview
questionnaire and that provides a link to the questionnaire. This template must be created and active before
legal users can begin creating interview questionnaires.

About this task

Important: You can modify interview templates that are in draft state. You cannot modify interview templates
that are in active or inactive states.

Procedure

To modify the template for the initial interview:

1. Click Initial Interview.
2. Enter a subject the Subject field.
3. Modify or enter the contents of the interview message, including text with different formats and fonts,

tables, and images.
4. Optional: To insert system variables into the content, select them from the System Variables list.

The system variables represent dynamic data, such as the name of a recipient or the name of an
attorney for the matter. When a interview is sent that contains system variables in the content, the
system variables are replaced with actual values.

If you want custodians to confirm receipt of the interview questionnaire, you can include a
Confirmation Link variable. This variable automatically inserts a web link that the custodian opens to
confirm receipt of the interview questionnaire.

Parent topic: Creating and configuring interview templates

Modifying the template for the follow-up message on the
initial interview

Follow-up messages are sent to recipients who did not respond to the initial interview. They contain a link to
the questionnaire and ask the recipients to complete and return the questionnaire.

About this task

Important: You can modify interview templates that are in draft state. You cannot modify interview templates
that are in active or inactive states.

Procedure

To modify an interview template follow-up message:

1. In the Rules section next to Initial interview, select the Require follow-up check box.
2. Configure how often the follow-up message is to be sent.

a. From the Follow-up frequency list, select the intervals between two follow-up messages. The
first follow-up message is sent based on the send date of the initial interview and the follow-up
frequency.
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b. In the Repeat field, select the number of times to send the follow-up message.
c. If you want to send a message to the manager of the recipient after the final follow-up message

is sent, select Allow escalation.
3. In the Contents section, click Follow-Up - Initial Interview.
4. Enter a subject in the Subject field.
5. Modify or enter the contents of the follow-up message, including text with different formats and fonts,

tables, and images.
6. Optional: To insert system variables into the content, select them from the System Variables list.

The system variables represent dynamic data, such as the name of a recipient or the name of an
attorney for the matter. When a interview is sent that contains system variables in the content, the
system variables are replaced with actual values.

If you want custodians to confirm receipt of the interview questionnaire, you can include a
Confirmation Link variable. This variable automatically inserts a web link that the custodian opens to
confirm receipt of the interview questionnaire.

Parent topic: Creating and configuring interview templates

Modifying the template for the recurring interview

Recurring interviews refresh the initial interview, and are sent to all recipients whether they responded to the
initial interview or not. The recurring interviews include a link to the questionnaire and have their own follow-
up messages that notify the recipients to complete and return the questionnaire.

About this task

Important: You can modify interview templates that are in draft state. You cannot modify interview templates
that are in active and inactive states.

Procedure

To modify an interview template repeat interview message:

1. In the Rules section next to Recurring interview, select the Include recurring interview check box.
2. Configure how often the recurring interview is to be sent.

a. From the Follow-up frequency list, select the intervals between two recurring interviews.
Important: You must set the frequency number to a value greater than zero in order for the
recurring interview to be sent.

b. In the Repeat field, select the number of times that the recurring interview to be sent. If you
select Indefinitely, the recurring interview keeps going out until the interview is closed.

3. In the Contents section, click Recurring Interview.
Recommendation: Reuse the text from the initial interview.

4. Enter a subject in the Subject field.
5. Modify or enter the contents of the interview message, including text with different formats and fonts,

tables, and images.
6. Optional: To insert system variables into the content, select them from the System Variables list.

The system variables represent dynamic data, such as the name of a recipient or the name of an
attorney for the matter. When a interview is sent that contains system variables in the content, the
system variables are replaced with actual values.
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If you want custodians to confirm receipt of the interview questionnaire, you can include a
Confirmation Link variable. This variable automatically inserts a web link that the custodian opens to
confirm receipt of the interview questionnaire.

Parent topic: Creating and configuring interview templates

Modifying the template for the follow-up messages on
recurring interviews

Follow-up messages are sent to those recipients who did not respond to a recurring interview. They contain a
link to the questionnaire and ask the recipients to complete and return the questionnaire

About this task

Important: You can modify interview templates that are in draft state. You cannot modify interview templates
that are in active and inactive states.

Procedure

To modify the template for the follow-up message on recurring interviews:

1. In the Rules section next to Recurring interview, select both the Require follow-up check box.
2. Configure how often the follow-up message is to be sent.

a. From the Follow-up frequency list, select the intervals between two follow-up messages. The
first follow-up message is sent based on the send date of the recurring interview and the follow-
up frequency.
Important: You must set the frequency number to a value greater than zero in order for the
follow-up message to be sent.

b. In the Repeat field, select the number of times that the follow-up message is to be sent.
c. If you want to send a message to the manager of the recipient after the final follow-up message

is sent, select Start of changeAllow escalation End of change.
3. Configure the contents of the follow-up message.

a. In the Contents section, click Follow-Up - Recurring Interview.
b. Enter a subject in the Subject field.
c. Modify or enter the contents of the follow-up message, including text with different formats and

fonts, tables, and images.
4. Optional: To insert system variables into the content, select them from the System Variables list.

The system variables represent dynamic data, such as the name of a recipient or the name of an
attorney for the matter. When a interview is sent that contains system variables in the content, the
system variables are replaced with actual values.

If you want custodians to confirm receipt of the interview questionnaire, you can include a
Confirmation Link variable. This variable automatically inserts a web link that the custodian opens to
confirm receipt of the interview questionnaire.

Parent topic: Creating and configuring interview templates
Start of change

Modifying the template for the questionnaire
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The questionnaire contains the questions and possible answers that are to help define the nature and scope
of the matter.

About this task

Important: You can modify interview templates that are in draft state only. You cannot modify interview
templates that are in active and inactive states.

Procedure

To modify template for the questionnaire:

1. Log in to the IBM® StoredIQ for Legal web client as a process administrator and click Templates.

The Templates page is displayed with a list of templates, including their names (as hypertext links),
status (draft, active, inactive) and modification dates.

2. Find the template in the list that you want to modify and then click the template name to open the
template.

3. Optional: Modify the template name and the description.
4. Click Questionnaire.
5. Optional: Next to Questionnaire Rules, select the Lock rules in interviews that use this template check

box if the questionnaire must not be edited when it is active.
6. To add a question, click New Question and specify the Question title, Question text, Description, and

Question type. The following question types are supported:
Option Description

Single-select
- radio button

Recipient selects one answer from a list of radio button choices. Select Follow-up

action required to enable an alert. Reorder the options by clicking the Reorder icon .
Single-select
- drop-down

Recipient selects one answer from a drop-down list. Select Follow-up action required to

enable an alert. Reorder the options by clicking the Reorder icon .
Multi-select -
check boxes

Recipient selects one or more answers from a multiple-choice list. Select Follow-up

action required to enable an alert. Reorder the options by clicking the Reorder icon .
Single-line
text

Recipient types the answer into a single field.

Paragraph
text

Recipient types the answer into a text box.

Select Required question to mark the question with a red asterisk (*) and prevent the recipient from
skipping it.

7. In the answers section, complete these steps:
a. Specify all possible answers. To add an answer, click Add Answer. To let the recipients specify an

answer, click Add "Other".
b. If an answer requires a follow-up action by the paralegal, select the Follow-up action required

check box. The paralegal is informed by an email when one or more recipients select this
answer.

c. If an answer requires a follow-up question, click the Create a conditional question icon .
Then, complete the conditional question.

d. Optional: To reorder the answers, click the Reorder icon  and then drag and drop the answer.
Alternatively, click in the answer field and then press Ctrl and the Up or Down Arrow key.

8. Optional: To duplicate or delete a question, use the icons to the right of the question headline.
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Parent topic: Creating and configuring interview templates
End of change

Creating, updating, and deleting matter categories

To improve matter management, you have the option of creating legal categories. For example, you might
create categories for IP Related, Internal, Financial, Regulatory, and Securities.

About this task

You can also make changes to the categories in the system, and delete any categories that are not yet
associated with a matter.

Procedure

To create, update, and delete a matter category, complete the following steps:

1. Log in to the StoredIQ for Legal web client as a process administrator with Content Settings privileges.
2. Start of changeClick Admin in the main menu and then click Content Settings then Matter Category.

End of change
3. In the Matter Category window, you can complete the following:

Create a new category by clicking the New Category button and completing the required fields.
Update the name of a category by entering the new name in the field of an existing category. This
new name will also appear in the details of any matter using the category.
Deactivate a matter category by dragging it into the Inactive matter category space (the inactive
matter category count will be updated).
Delete a category by clicking the X next to the category name. Note that if a deleted category is
in use, then the category value in matters will be cleaned up.
View the list of categories in the system.

4. Click Save to save the changes.

Parent topic: Administering your StoredIQ for Legal processes

Configuring hold notice settings

You can customize the confirmation page and confirmation link instructions for the legal hold notices that
IBM® StoredIQ for Legal legal users send.

Procedure

1. Log in to the StoredIQ for Legal web client as a process administrator with Content Settings privileges.
2. Start of changeClick Admin > Content Settings > Hold Notice. End of change
3. Start of changeUnder Confirmation Page, in the Confirmation question field, enter the text that is to

be displayed before the Confirm button in the confirmation page. End of change
4. Start of changeClick Preview to display the confirmation page with text that you entered in the

Confirmation question field. End of change
5. Under Confirmation Link, in the Link descriptor field, enter the text that is to be displayed before the

confirmation link in the notice message that the custodians receive.
6. Click Save to save the changes you made.

Parent topic: Administering your StoredIQ for Legal processes
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Configuring data source types for requests

Start of changeYou must configure the list of data source types in your enterprise so that the legal staff can
select the locales when creating requests. A process administrator can assign source types to data locales,
add locales, modify locales, and remove locales. End of change

Procedure

To configure the data source types for your system, complete the following steps:

1. Log in to the StoredIQ for Legal web client as a process administrator with Content Settings privileges.
2. Start of changeClick Admin in the main menu and then click Content Settings then Data Request.

End of change
3. In the Data Request window, you can complete the following:

Define a new data locale by clicking the New Locale button and specifying the required
information.
Modify existing volume types by dragging and dropping them.
Delete previously defined data locales.

Start of change

What to do next

If you re-configure the data source types or locales after a legal user has already created a data request, then
that data request will retain the old configuration but any new requests will use the new configuration.

End of change
Parent topic: Administering your StoredIQ for Legal processes

Start of change

Customizing custodian attributes

Custodian attributes define information about each custodian, for example, login ID, first and last name, e-
mail address, manager, and department. You can define custom attributes for your system.

About this task

Requirement: Start of changeBoth the Login ID and Person ID are system required attributes. The Login ID
identifies the unique ID that each custodian logs in as. The Person ID is intended to identify each custodian by
a unique corporate identification string. For example, you can use Person ID to store each custodian's
employee serial number, and rename the attribute to Employee Serial Number. Legal users could then search
for, filter, and sort custodians by employee serial number. Note that the Person ID can only be modified
through the original LDAP record. End of change

Procedure

To define the custom custodian attributes for your system, complete the following steps:

1. Log in to the StoredIQ for Legal web client as a process administrator with Content Settings privileges.
2. Click Admin in the main menu and then click Content Settings then Custodian Attributes. An ordered

list of the existing custodian attributes displays.
3. In the Custodian Attributes window, click New Attribute.
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4. Specify the Attribute Name.
5. Select the Data Type and click the advanced configuration tool icon to specify the options for it (options

with a red asterisk (*) are required):
Opt
ion Description

Stri
ng

A string attribute. You must specify a maximum String Length. Once the String Length value is set
in a custom attribute, it cannot be modified.

Nu
mb
er

A number attribute. You must specify the Decimal Places, which denotes the number of digits to
the right of the decimal point. For example, 0 would make the number an integer. Once the
Decimal Places value is set in a custom attribute, it cannot be modified.

Dat
e

A date attribute.

Boo
lea
n

An attribute with a value of either true or false.

Ch
oic
e
List

A list of multiple-choice options. You must specify Choice List options. Choice List options can be
added or removed later.

6. Optional: Reorder the attributes by dragging and dropping the ordered number, or by focusing on the
attribute name and pressing Ctrl plus the up/down arrow keys.

7. Optional: Click Delete to remove a custodian attribute that is not in use yet. You cannot remove
attributes that have values set in them.

8. Click Save to save the custodian attributes, or click Revert to discard all of the changes you made since
the last save.

Parent topic: Administering your StoredIQ for Legal processes
End of change

Managing legal matters

You can use StoredIQ for Legal to manage the lifecycle of a matter, including creating and managing matters,
matter hold notices, and preservation requests.

Managing notifications
The Notifications page is a custodian portal that consolidates all of a custodian's hold notices and
interviews in one place.
Managing matter lifecycles
Legal users with Matters privileges can use StoredIQ for Legal to manage the lifecycle of a matter. They
can create a matter, create related hold notices, interviews, and data requests, and close a matter
when all of the related tasks are complete.
Managing notices
A notice, typically in email, is a formal instruction to custodians to preserve documents and information
that is relevant to a matter, and suspend normal retention and destruction schedules.
Managing interviews
Legal users with Interview privileges can use interviews to send email questionnaires to custodians to
identify information that pertains to legal matters.
Editing email contents
When you edit a message for a hold notice or interview, StoredIQ for Legal displays a number of
message edit buttons above the text box.

IBM StoredIQ for Legal 2.0.1 41



Requesting matter data
A key step in the legal matter management process is identifying, finding, and preserving all data that is
relevant to the legal matter. Legal users with Data Requests privileges can use StoredIQ for Legal to
complete the tasks of identifying, finding, and preserving data that is relevant to the matter by creating
requests.
Legal matter reports
To help paralegals and attorneys manage legal matters, StoredIQ for Legal provides the Global
Custodians and Matter Data reports (in the form of CSV files). The reports are in the Reports tab in the
StoredIQ for Legal web client.

Start of change

Managing notifications

The Notifications page is a custodian portal that consolidates all of a custodian's hold notices and interviews
in one place.

About this task

The Notifications page allows custodians to access all of their hold notices and interviews from a single
location rather than from each individual e-mail notification. By default, the hold notices and interviews that
require a response are listed first.

Procedure

To manage notifications:

1. Log in to StoredIQ for Legal.
2. Click Notifications.
3. Expand Attention Required to list the hold notices and interviews that require your response or review.

Any hold notices and interviews that have been flagged as Escalated because the required time to
respond or review has elapsed automatically moves to the top of the list.

4. In the same pull-down menu, select Done to see completed notifications or All to see all notifications.
You can also sort the list in Ascending or Descending order by Date Issued or Last Modified.

5. Click the hold notices or interviews with a status of Response Required. After you complete them, their
status will change to Responded.

6. Optional: If you already submitted an interview but would like to submit a change, revise your answers
in the questionnaire and click Resubmit.

Parent topic: Managing legal matters
End of change

Managing matter lifecycles

Legal users with Matters privileges can use StoredIQ for Legal to manage the lifecycle of a matter. They can
create a matter, create related hold notices, interviews, and data requests, and close a matter when all of the
related tasks are complete.

About this task
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A matter is used to structure and group legal activities. Examples of matter include intellectual property
disputes, malpractice claims, workplace discrimination allegations, and so forth.

When a matter arises, the legal team must be prepared to meet preservation and eventually discovery
requirements. Any document that falls in the scope of the matter falls under the obligations to preserve and
eventually produce.

Creating a matter
Create a matter to manage the lifecycle of a legal matter. In StoredIQ for Legal, a matter is a container
that encapsulates all of the data that you are gathering for an actual or potential legal case.
Modifying matter information
In the matters page, a legal user with Matters privileges can modify the matter details, such as change
the matter category, change the attorney and the paralegal, modify the matter attachments, or add
more attachments.
Managing a matter
The matter dashboard provides a summary view of the matters that you are associated with and a high-
level overview of the status of matter notices, interviews, and data boxes (data requests). You can also
see details about the various aspects that pertain to the matter.
Closing or deleting a matter
When all of the notices and requests that are associated with a matter are closed Start of changeor
suspended End of change, a legal user with the Close Matters privilege can close a matter. If there
are no notices, interviews, or data requests that are associated with the matter, a matter can be
deleted.

Parent topic: Managing legal matters

Creating a matter

Create a matter to manage the lifecycle of a legal matter. In StoredIQ for Legal, a matter is a container that
encapsulates all of the data that you are gathering for an actual or potential legal case.

Start of change

Before you begin

Before you create a matter, matter categories must be available, and you must be assigned a role with the
Manage Matters privilege such as Attorney, Paralegal, or Data Ops. Contact your administrator for more
information. End of change

About this task

In StoredIQ for Legal, all legal processes start with the creation of a matter. To put a matter into action, you
create hold notices, interviews, or data boxes.

Procedure

To create a matter:

1. Log in to StoredIQ for Legal as a legal user with the Manage Matters privilege.
2. Go to Matters and click New Matter.
3. Start of changeIn the Create Matter window, enter the necessary information or select from the

drop-down menu options, as applicable.
Table 1.
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Fiel
d

na
me

Description

Fiel
d

na
me

Description

Mat
ter
na
me

A unique name for the matter. The matter name appears on the matter dashboard page and
provides an efficient way to identify the matter. You can click the matter name (a hypertext link) to
open the matter.

This field is required.
Mat
ter
ID

A non-unique ID for the matter. The matter ID appears on the matter dashboard page and
provides an efficient way to identify the matter. You can click the matter ID (a hypertext link) to
open the matter and you can search for a matter with its matter ID throughout StoredIQ for Legal.

This field is required.
Cat
ego
ry

The matter category.

This field is optional.

Des
crip
tion

The matter description.

This field is optional.

Att
orn
ey

The attorney who is associated with the matter. You can select only 1 attorney.

This field is optional.

Par
ale
gal

The paralegal who is associated with the matter. You can select only 1 paralegal.

Paralegal is required to send notice emails.

Dat
a
Ops

The user that serves as the legal operations contact for the matter. The users in the list are pre-
populated by the StoredIQ for Legal system administrator. You can select only one Data Ops
contact.

Data Ops is optional and cannot be added if a IBM® StoredIQ server is not configured. Data Ops is
required if the data box functionality is required.

Att
ach
me
nts

Attachments that are related to the matter (limit of 50 MB per file).

End of change
4. Click Create to create the matter.

Results

The new matter appears in the matters dashboard.
Parent topic: Managing matter lifecycles

Modifying matter information

In the matters page, a legal user with Matters privileges can modify the matter details, such as change the
matter category, change the attorney and the paralegal, modify the matter attachments, or add more
attachments.

Procedure
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To modify the details for a matter:

1. In the matters page, click the matter name to open it.
2. Click Expand Details.
3. Modify the details. You can also add more attachments (limit of 50MB).
4. Click Save and Collapse Details.

Parent topic: Managing matter lifecycles

Managing a matter

The matter dashboard provides a summary view of the matters that you are associated with and a high-level
overview of the status of matter notices, interviews, and data boxes (data requests). You can also see details
about the various aspects that pertain to the matter.

About this task

At a high-level, the matter dashboard comprises the following main areas.

Matter dashboard landing page
When you log in to StoredIQ for Legal as a legal user with Matter privileges, the web client displays the
matter dashboard. The matters that you are associated with are shown and you can open the matters
to work with them or view status. You can also create a new matter from the main page of the matter
dashboard.

You can also search for matters by using the simple or advanced search feature. When you run a
search, you can enter search criteria to narrow the results. You can sort the results to make it easier to
understand the list of results.

Matter page
Legal users with Matters privileges can open a matter from the matter dashboard landing page, which
provides an overview of the hold notices and data boxes that are associated with the matter. If you
need to modify or get specific details for a notice or request, you can complete those actions from the
matter details page. You can also create notices or data boxes from the matter page.

Notices page
When legal users with Notices privileges select a particular notice from the matter details page, an
overview of all notices that are associated with the matter are shown. From the page, you can create a
new notice. You can also open a specific notice to get more detailed information and modify the notice,
such as add or release custodians.

Start of changeInterviews page End of change
Start of changeWhen legal users with Interviews privileges select a particular interview from the

matter details page, an overview of all interviews that are associated with the matter are shown. From
the page, you can create a new interview. You can also open a specific interview to get more detailed
information and modify the interview, such as add or release custodians. End of change

Data Box page
From the matter details page, legal users with Data Requests privileges can access the Data Box page,
which provides a summary of all of the data boxes for the matter. In the Data Box page, you can see an
overview of the number of data boxes for the matter, the state of the data boxes, and so forth.

You can also create a new request. By opening a specific request, you can modify it or view the status
and other request details.

Parent topic: Managing matter lifecycles
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Closing or deleting a matter

When all of the notices and requests that are associated with a matter are closed Start of changeor
suspended End of change, a legal user with the Close Matters privilege can close a matter. If there are no
notices, interviews, or data requests that are associated with the matter, a matter can be deleted.

Procedure

To close or delete a matter:

1. Log in to the StoredIQ for Legal web client as a user with the Close Matters privilege.
2. Go to the Matters page and locate the matter that you want to close or delete.
3. In the column that contains the date that the matter was modified, click the Close link to close the

matter, or Delete to delete the matter if there are no associated notices or requests. You can also click
the matter name to open it, and then select Close or Delete from the Actions menu.

Parent topic: Managing matter lifecycles

Managing notices

A notice, typically in email, is a formal instruction to custodians to preserve documents and information that is
relevant to a matter, and suspend normal retention and destruction schedules.

About this task

Notices provide details about the nature of a matter and the information that must be preserved. Legal users
with Notice privileges can configure a notice to require confirmation from custodians that the information will
be preserved (until you are notified that the information can be safely deleted). They can also configure a
notice to be resent periodically to remind custodians about any new information that must be preserved.

A custodian who receives a hold notice is considered to be on hold until they are released from the
preservation requirement.

Attention: Before you can create a notice, the following tasks must be complete:

The email server must be configured.
The custodians must be created.
A notice template must be created with, at minimum, an initial message.

Creating and sending hold notices
Hold notices advise people to preserve documents and information that are pertinent to a legal case,
and to suspend normal retention and destruction schedules.
Receiving and responding to hold notices
Custodians receive hold notice emails that contain instructions on how to respond along with a
confirmation web link.
Viewing hold notice response and confirmation status
Legal users with Notices privileges can view the status of hold notice custodian responses and
confirmations in the matters dashboard, individual matters and published hold notices.
Updating custodians for a published notice
A legal user with Notices privileges can add or remove custodians after a notice is published. Also, a
legal user with the Manage Matter privilege can confirm notices on behalf of custodians.
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Parent topic: Managing legal matters

Creating and sending hold notices

Hold notices advise people to preserve documents and information that are pertinent to a legal case, and to
suspend normal retention and destruction schedules.

Before you begin

Requirement: Your process administrator must create a hold notice template first. You are required to select a
hold notice template before you can create a hold notice.

About this task

Each hold notice describes the type of information that needs to be preserved and the responsibilities of the
custodians. Optionally, you can insert a confirmation variable that requires the custodians to confirm that they
understand their obligations and that they must comply. You create a hold notice by selecting a notice
template, and then modifying the notice as needed. You then send it to a set of custodians in an email.

Procedure

To create a hold notice:

1. Log in to the StoredIQ for Legal web client as a user with Notices privileges and click Matters.
2. Click the name of the matter, which is a hypertext link, for which you want to create the hold notice.
3. Click New Notice.
4. Required: On the Create Notice page, enter the notice name in the Name field. If you ever plan to add

the notice name variable into the email message, make sure that the Name is unique and meaningful to
the custodians who receive the notice.

5. Optional: Enter a brief description in the Description field.

If you want the custodians to see the description text in the email message, you can use the notice
description variable.

6. Click Create.
7. In the Select a Template to Start page, select a template from the list or using the search.

Start of changeThe Message page shows the message rules and the contents of the hold notices and
the follow-up messages, as defined in the selected template. End of change

8. Start of changeIf the message rules are not locked, you can change them. End of change
9. Start of changeUnder Contents, change the contents of the hold notices and the follow-up

messages, as necessary. End of change

If you want the custodians to confirm the receipt of a hold notice, you can include a Confirmation Link
variable. This variable automatically inserts a web link that the custodian opens to confirm receipt of
the hold notice. The Confirmation Link variable must be included if you plan to send out follow-up
messages and reminder notices.

Restriction: You cannot drag images into the message content.

In addition to the initial notice, the following items can be sent:

Start of change
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Follow-up - Initial notice
Enabled by selecting the Require confirmation and follow-up check box in the Initial notice
section. Follow-up messages are sent to the custodians who did not respond to the initial notice,
notifying them to confirm the receipt of the initial notice. The first follow-up message is sent
based on the send date of the initial notice and the specified follow-up frequency. The 

Start of changeAllow escalation End of change option sends a message to the manager of
the custodian after the final follow-up message is sent.

Start of changeReminder notice End of change
Enabled by selecting the Include reminder check box in the Reminder notice section. A reminder
notice refreshes the initial notice, and is sent to all custodians at the specified follow-up
frequency, regardless of whether the custodians responded to the initial notice. A reminder
notice becomes the new notice (thereby resetting all previously recorded metrics for the notice
in the custodian status reports), requires a new confirmation, and has its own follow-up
messages. If a reminder notice is set to repeat, then each new issuance is treated as a new
notice. If a reminder notice repeats Indefinitely, then the reminder notice keeps going out until
the hold notice is closed.

Start of changeFollow-up - Reminder notice End of change
Start of changeEnabled by selecting the Require confirmation and follow-up check box in the

Reminder notice section. Follow-up messages are sent after the reminder notice is sent to notify
custodians to confirm. The first follow-up message is sent based on the send date of the
reminder notice and the specified follow-up frequency. The Allow escalation option sends a
message to the manager of the custodian after the final follow-up message is sent.

End of change

End of change
10. Click Save Draft to save all changes. Note that the changes do not affect the notice template.
11. Optional: Send a preview of the message contents to selected users who have the View Notices

privilege, including yourself, by clicking Start of changeSend test message End of change. You can
preview a particular message or all the messages, and you can specify an email address to send the
messages to. You might want to send it to yourself first to verify that the contents is correct. You can
modify it and preview it again repeatedly. After you are satisfied with the contents, you can preview it
again and send it to the matter attorney for final approval before you publish it.

12. Click Custodians to list the custodians that will receive the notice. Start of changeYou can search for
custodians or sort the list by clicking on the column headings. You can also hide or display columns by
clicking on the custodian attributes button. End of change

13. Click + Custodians and select the check box next to each custodian that you want to receive the notice. 
Start of changeYou can search for specific users by entering their names in the search field at the top

of the list. You can also filter the list of recipients to choose from by selecting a group in the pull-down
menu:

Matter Custodians
List of notices and interviews. If you select one, all custodians in that notice or interview display.

Groups
List of custodian groups created by your system administrator. If you select one, all members in
that group display.

End of change
14. Start of changeOn the Review page, specify a reason for adding the custodians. Then, click Add

Custodians to add them. End of change
15. Review the hold notice for accuracy and make any necessary changes.
16. Click Publish to publish the hold notice.

Results
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You can see confirmation responses by opening the published notice, where a timeline graph is also included.
You can also notice metrics such as confirmations and escalations in both the Matters and Notice dashboards.

The exact time that the hold notice is sent is determined by the email settings, which are set by a system
administrator.

Parent topic: Managing notices
Related reference:

Editing email contents
System variables

Receiving and responding to hold notices

Custodians receive hold notice emails that contain instructions on how to respond along with a confirmation
web link.

Before you begin

The custodians must have valid email accounts on the email server that is configured in the IBM® StoredIQ for
Legal Admin > External Servers > Email Server page. Otherwise, StoredIQ for Legal cannot detect
transmission errors (unless the domain is incorrect) and an undeliverable notice email is sent to the matter
paralegal.

It is assumed that custodians have an email application that they use to connect to the email server to read
and send email.

Procedure

To respond to hold notice emails:

1. In the email application, open the hold notice email.

Start of changeThe email explains what you (the custodian) must do to comply with the legal hold
request. It typically includes the Click to Respond confirmation link, and might contain one or more
attachments. End of change

2. Click Click to Respond.

The StoredIQ for Legal login page is displayed in the web browser.

3. Log in to StoredIQ for Legal with your user name and password.

The Notice Confirmation Details page is displayed. It contains further instructions on how to comply
with the hold request and a confirmation link.

4. Click Confirm to confirm receipt of the hold notice email.

A pop-up window is displayed to verify that you want to continue.

5. Click Confirm.
6. If you want to be contacted by the StoredIQ for Legal user who sent you the hold notice, click Contact

Me.

Parent topic: Managing notices
Related tasks:
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Managing notifications

Viewing hold notice response and confirmation status

Legal users with Notices privileges can view the status of hold notice custodian responses and confirmations
in the matters dashboard, individual matters and published hold notices.

Procedure

To view the status of hold notice custodian responses and confirmations:

1. Log in to the IBM® StoredIQ for Legal web client as a user with the Paralegal or Attorney role and click
Matters.

A list of matters is displayed. Next to each matter is a set of metrics that summarizes the status of all
published hold notices for the matter. The metrics include a Total Files donut chart and a Custodians
donut chart that are color-coded. Each color-coded segment of the Custodians donut chart shows the
percentage of custodians with a particular status. For example, gray for released custodians, yellow for
rejected custodians, blue for contact custodians, and orange for escalation and transmission errors. To
see the percentage of any status type, hover the mouse pointer over the shaded segments of the donut
chart.

2. Click the name of a matter, which is a hypertext link, to open the page for that matter and click Notices.
A set of metrics is displayed for all hold notices that are associated with the matter that includes the
following information:

A donut chart that shows the total number of custodians who were notified with all published
hold notices (Notified)
A count of the total number of custodians who confirmed receipt of all hold notices (Confirmed)
A count of the total number of custodians who asked to be contacted for all hold notices
(Contact)
A count of the total number of custodians who did not receive hold notices due to transmission
errors and for whom there is a notice escalation (Attention)

A list of hold notices for the matter is also shown. Next to each hold notice is a color-coded bar that
shows the status of the custodians for that hold notice. Each color-coded segment shows the relative
percentage for each custodian status type. The colors and their associated statuses match the colors
that are displayed in the donut chart at the beginning of the page.

3. In the list of hold notices, click the name of a published hold notice, which is a hypertext link.
The Hold Notice Overview page is displayed. It contains a timeline chart, which is updated once a day,
that shows the status of the custodians who were sent the hold notice as a function of time. The chart
shows the following status types, each of which has an associated number of custodians:

Sent
Confirmed
Contact
Attention

Start of changeSuspended End of change
The timeline chart has two axes:

Custodians (vertical axis): the number of custodians who were sent the notice
Date (horizontal axis): points in time since the notice was sent

To see the status for all custodians on a specific date, move the mouse pointer over the icons. You see
the following information:

Date of the status
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Active custodians
Sent
Confirmed
Contact
Attention

You can hover the mouse pointer over various points on the graph to see the status of the custodians.

You can filter a list of custodians, for example, searching only for custodians who confirmed, rejected,
or responded to a hold notice.

4. Start of changeClick Notice Contents to see the contents of the hold notice. End of change
5. Optional: Start of changeTo see details about the hold notice such as description, matter, and dates,

click Expand Details.
Restriction: The Suspend Notice button permanently pauses the hold notice from sending any further
messages to the custodians. Note that once a hold notice is in Suspended state, it cannot be resumed.

End of change

Parent topic: Managing notices

Updating custodians for a published notice

A legal user with Notices privileges can add or remove custodians after a notice is published. Also, a legal user
with the Manage Matter privilege can confirm notices on behalf of custodians.

About this task

If you add one or more custodians after a notice is published, the custodians that you add receive the initial
notice, even if the publish date is passed. The custodians that you add also receive follow-up notices at
regular intervals that start from the initial notice date. For example, if the initial follow-up interval is one week,
then every follow-up message is sent on the same day each week beginning from the initial notice date,
regardless of when the target custodian was added. If a custodian was added some time after the initial
notice date, then they still receive the follow-up one week after the initial notice date as opposed to one week
after the date they were added.

Hold notice reminders are sent on schedule with the original publish date.

When you release a custodian after the hold notice is published, a release notice is sent to the custodian.

Users who belong to other hold notices that are in draft or sent state are automatically added to a matter
custodians list. Users who got released or deleted from the hold notices (draft) state are removed
automatically.

Start of changeLegal users with the Manage Matter privilege can also confirm hold notices on behalf of
custodians by selecting them and clicking Confirm (a Reason for action is required). As a result, the status of
those custodians changes to Confirmed with an asterisk (*) next to it and your name as the action performer.

End of change

You cannot add, remove, or confirm custodians after the notice is closed, and you cannot reopen or reactivate
a closed notice to be active.

Procedure

To add or release a custodian:
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1. Log in to the IBM® StoredIQ for Legal web client as a user with the Paralegal or Attorney role and click
Matters.

2. In the Matters page, click the appropriate matter to open it.
3. In the Notices section, click the name of the published notice that you want to modify.
4. To add one or more custodians, click Add Custodian to open the Add Custodians window.
5. Search for custodians or select from the list, and then click Review Selection.
6. Review the list of custodians and related messages information, then click Add Custodians.
7. To release a custodian, select the custodian from the list and click Release.
8. In the Release Custodians window, enter a reason for releasing the custodian and then click Release.

Parent topic: Managing notices
Start of change

Managing interviews

Legal users with Interview privileges can use interviews to send email questionnaires to custodians to identify
information that pertains to legal matters.

About this task

Paralegals and attorneys typically need to submit detailed questionnaires to custodians to find out which
information custodians might have that pertains to a legal matter. Paralegals and attorneys create interviews
for a matter to define and distribute questionnaires in a controlled and consistent way, and track the
responses from the custodians. With an interview, you can create a reusable questionnaire, send interview
notifications automatically and repeatedly, and define an escalation process for custodians who do not
respond in a timely manner.

Attention: Before you can create an interview, you must complete the following tasks:

The email server must be configured.
The custodians must be created.
An interview template must be created with, at minimum, an initial message.

Creating and sending interviews
Legal users with Interview privileges can create and send interviews to identify information that
pertains to legal matters.
Viewing and acting on interview results
Legal users with Interview privileges can view the status of interview responses in matters and
published interviews, and download all interview answers in a CSV file. If the answer of an interviewee
requires a follow-up action, the paralegal user is informed and can take the appropriate action.
Receiving and responding to interview requests
Custodians receive email notifications of interview requests that contain questionnaires that they must
answer.

Parent topic: Managing legal matters
End of change
Start of change

Creating and sending interviews

Legal users with Interview privileges can create and send interviews to identify information that pertains to
legal matters.
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Before you begin

Requirement: Your process administrator must create an interview template first. You are required to select
an interview template before you can create an interview.

About this task

Each interview contains a questionnaire that the recipients must answer. You create an interview by selecting
an interview template and modifying the interview as needed. You then send the interview to a set of
recipients in an email.

Procedure

To create an interview:

1. Log in to the StoredIQ for Legal web client as a user with Interviews privileges and click Matters.
2. Click the name of the matter, which is a hypertext link, for which you want to create the interview.
3. Click Interviews
4. Click New Interview.
5. Required: On the Create Interview page, enter the interview name in the Name field. Ensure that the

name is unique and meaningful to avoid confusion with other interviews.
6. Optional: Enter a brief description in the Description field.
7. Click Create.
8. Select an interview template from the list.

Important: You must select a template to continue with creation of the interview.

The Message page shows the message rules and the contents of the interview messages and the
follow-up messages, as defined in the selected template.

9. If the message rules are not locked, you can change them.
10. Under Contents, change the contents of the interview messages and the follow-up messages, as

necessary.
Important: You must include the {Interview Link} system variable in the initial interview and the
recurring interview. A web link is substituted for the variable in the email that is sent to a recipient and
the recipient opens the link to see the questionnaire and respond.
In addition to the initial interview, the following items can be sent:

Follow-up - Initial interview
Enabled by selecting the Require follow-up check box in the Initial interview section. Follow-up
messages are sent to the recipients who did not respond to the initial interview, notifying them
to complete the questionnaire. The first follow-up message is sent based on the send date of the
initial interview and the specified follow-up frequency. The Start of changeAllow escalation

End of change option sends a message to the manager of the recipient after the final follow-
up message is sent.

Recurring interview
Enabled by selecting the Include recurring interview check box in the Recurring interview
section. A recurring interview refreshes the initial interview, and is sent to all recipients at the
specified follow-up frequency, regardless of whether the recipients responded to the initial
interview. A recurring interview becomes the new interview (thereby resetting all previously
recorded metrics for the interview in the recipient status reports) and has its own follow-up
messages. If a recurring interview is set to repeat, then each new issuance is treated as a new
interview. If a recurring interview repeats Indefinitely, then the recurring interview keeps going
out until the interview is closed.
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Follow-up - Initial interview
Enabled by selecting the Require follow-up check box in the Recurring interview section. Follow-
up messages are sent to the recipients who did not respond to the recurring interview, notifying
them to complete the questionnaire. The first follow-up message is sent based on the send date
of the recurring interview and the specified follow-up frequency. The Allow escalation option
sends a message to the manager of the recipient after the final follow-up message is sent.

11. Create the questionnaire.

Create the list of questions that comprise the interview.

a. Click New Question.
b. In the Question title field, enter a title for the question.
c. In the Question text field, enter the question.
d. In the Description field, enter a brief description of the question.
e. From the Question type list, select the type of control that is to be displayed to the interviewee.

The possible controls include radio buttons, drop-down selection lists, check boxes, and text
input fields.

Select Required question to mark the question with a red asterisk (*) and prevent the
interviewee from skipping it.

f. In the answer section, continue as follows:
Specify all possible answers.
If an answer requires a follow-up action that is to be completed by the paralegal, select
the Follow-up action required check box. The paralegal is informed by an email when one
or more recipients select this answer.
If an answer requires a conditional question, click the Create a conditional question icon 

. Then, complete the conditional question.
If you want a conditional question to be shown for only one answer to the parent
question, select the answer in A conditional question of in the conditional question.
If you want a conditional question to be shown for more than one answer to the parent
question, click + Add Condition for each additional answer. Each click of + Add Condition
adds another A conditional question of list box which you can use to select an additional
answer.

To reorder the answers, click the Reorder icon  and then drag and drop the answer.
Alternatively, click in the answer field and then press Ctrl and the Up or Down Arrow key.

Important: If you create dependencies between questions, be careful when you move and
delete questions to not create an invalid or confusing questionnaire.

g. To add an answer, click + Add Answer. To let the interviewees specify an answer, click Add
"Other".

12. Select the recipients to receive the interview request.
a. Click Recipients to list the users that will receive the interview. Start of changeYou can search

for users or sort the list by clicking on the column headings. You can also hide or display
columns by clicking on the attributes button. End of change

b. Click + Recipients and select the check box next to each user that you want to receive the
interview emails. You can search for specific users by entering their names in the search field at
the top of the list. You can also filter the list of recipients to choose from by selecting a group in
the pull-down menu:

Matter Custodians
List of notices and interviews. If you select one, all custodians in that notice or interview
display.
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Groups
List of custodian groups created by your system administrator. If you select one, all
members in that group display.

c. Click Review Selection. The list of recipients you selected is displayed. You can revise the list as
needed.

d. When you are satisfied with the list, specify a reason for adding the recipients. Then, click Add
Recipients to save the recipients list.

13. In the left pane, click Save Draft to save your changes. The changes do not affect the interview
template.

14. Optional: Send a preview of the message contents to selected users who have the View Notices
privilege, including yourself, by clicking Start of changeSend test message End of change. You can
preview a particular message or all the messages, and you can specify an email address to send the
messages to. You might want to send it to yourself first to verify that the contents is correct. You can
modify it and preview it again repeatedly. After you are satisfied with the contents, you can preview it
again and send it to the matter attorney for final approval before you publish it.

15. Review the interview for accuracy and make any necessary changes.
16. Click Publish to send the interview.

Results

You can see interview responses by opening the published interview, where a timeline graph is also included.
You can also see interview metrics, such as responses and escalations, in both the Matters and Interview
dashboards.

The exact time that the interview is sent is determined by the email settings, which are set by a system
administrator.

Parent topic: Managing interviews
Related reference:

Editing email contents
System variables

End of change
Start of change

Viewing and acting on interview results

Legal users with Interview privileges can view the status of interview responses in matters and published
interviews, and download all interview answers in a CSV file. If the answer of an interviewee requires a follow-
up action, the paralegal user is informed and can take the appropriate action.

Procedure

To view the status of interview responses:

1. Log in to the IBM® StoredIQ for Legal web client as a paralegal user and click Matters.

A list of matters is displayed.

2. Click the name of a matter, which is a hypertext link, to open the page for that matter and click
Interviews.
For all interviews that are associated with the matter, a set of metrics is displayed that includes the
following information:
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A color-coded donut chart that shows:
The total number of recipients (custodians) who were sent interviews (Sent)
The total number who responded to the interviews (Responded - blue segment)
The total number who did not respond (Pending - gray segment)
The total number who did not receive the interviews due to transmission errors (Attention
- red segment)
The total number of recipients that the interview was concluded for (Concluded - black
segment)

A count of the total number of recipients who responded to interviews (Responded) along with
the number of follow-up actions required.
A count of the total number of recipients who did not respond to interviews (Attention) along
with those recipients who did not receive interviews due to transmission errors.

A list of interviews for the matter is also shown. Next to each interview is:
A color-coded bar that shows the status of the recipients for that interview. Each color-coded
segment shows the relative percentage for each recipient status type. The colors and their
associated statuses match the colors that are displayed in the donut chart at the beginning of
the page.
The date the interview was created, published, or updated.
The name of the interview template that is used to create the interview.
The number of follow-up actions required.
The number of interview recipients (custodians).

3. In the list of interviews, click the name of a published interview, which is a hypertext link.
The following tabs are displayed that contain interview results information:

Overview (selected by default)
Results
Rules and Contents

4. Click Overview.
The Overview page is displayed that contains:

The number of interview recipients who responded.
The number of follow-up actions required.
The list of recipients.
The status of each recipient.
The custodian attributes of each recipient.

5. Click Results.

The Results page is displayed.

a. Click View by Question to display:
A drop-down list of interview questions from which you can select.
For each interview question:

A pie chart (1 answer) or bar chart (multiple answers) that shows the numbers and
percentages of the different possible answers to the question.
The list of recipients with their answers to the question.
If an answer requires a follow-up action, a check box is displayed in the Follow-Up
Action column. Select this check box after you complete the required action. In the
Note column, you can specify a comment on your action.

b. Click View by Recipient to display:
A drop-down list of interview recipients from which you can select.
For each recipient:

The recipient's profile, including given name, surname, person ID, email address,
department, manager, status, and note that are entered by the paralegal.
The list of questions and the recipient's responses. If the recipient did not respond,
the question list is not displayed
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If an answer requires a follow-up action, a check box is displayed in the Follow-Up
Action column. Select this check box after you complete the required action. In the
Note column, you can specify a comment on your action.

6. Click Rules and Contents to see the message rules and the contents of the individual messages.
7. In the Issuance pull-down menu, you can switch to the initial interview or a recurring interview.

Parent topic: Managing interviews
End of change
Start of change

Receiving and responding to interview requests

Custodians receive email notifications of interview requests that contain questionnaires that they must
answer.

Before you begin

The custodians must have valid email accounts on the email server that is configured in the IBM® StoredIQ for
Legal Admin > External Servers > Email Server page. Otherwise, StoredIQ for Legal is not able to detect
transmission errors (unless the domain is incorrect) and an undeliverable interview request email is sent to
the matter paralegal.

It is assumed that custodians have an email client application that they use to connect to the email server to
read and send email.

Procedure

To respond to interview request emails:

1. In the email application, open the interview request email.

The email explains what the interview request is about and includes the Take the questionnaire link.

2. Click Take the questionnaire.

The StoredIQ for Legal login page is displayed in the web browser.

3. Log in to StoredIQ for Legal with your user name and password.

The page with the questionnaire is displayed.

Important: If the interview page status is Response Required, you must complete the questionnaire.
4. Complete the questionnaire. During idle periods, unsaved questions are saved automatically.
5. Click Submit.

A pop-up window is displayed to confirm that you want to submit your responses.

6. Click Submit.

The interview page status changes to Responded and the date and time of the response are displayed.

7. If necessary, you can reopen the questionnaire and change your responses.
a. Click the Questionnaire link to open the questionnaire.
b. Click the Revise Answers link to change your responses.
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Note: Submitted responses are read-only by default, so you must click Revise Answers to
change them.

c. Change the responses as needed and click Resubmit.

A pop-up window is displayed to confirm that you want to submit your responses.

d. Click Submit.

Parent topic: Managing interviews
Related tasks:

Managing notifications
End of change
Start of change

Editing email contents

When you edit a message for a hold notice or interview, StoredIQ for Legal displays a number of message edit
buttons above the text box.

The edit buttons complete the following functions:

Undo
Reverses your last edit.

Redo
Restores the last edit that you undid.

Insert

Link
Makes the text that you highlight (or if no text is highlighted, the default text in the Text to
display) into a hyperlink that points to the URL. You must make sure that the URL contains the
full web link that includes http:// or https://. You can specify the Target as Same Frame
(display the page in the browser window that is being used), New Window (display the page in a
new browser window), Whole Page (display the page in the entire browser window), or Parent
Frame (display the page in the window that the current window is nested in).

To view the settings of an existing link, double-click the link to see the window. You can also
highlight the link and click InsertLink to see the window with the link settings.

Image
Upload a graphic into the message.

Media
Embeds code to a video.

Table
Creates a table with the number of rows and columns you highlight.

Special Character
Inserts a special character.

Horizontal Rule
Creates a horizontal line in the message.

Styles
Stylizes text as a heading, sub-heading, or paragraph.

Bold
Applies bold style to the text.

Italic
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Applies italic style to the text.
Underline

Applies underline style to the text.
Alignment

Align Left
Applies left justification to the text.

Align Center
Centers the text.

Align Right
Applies right justification to the text.

Align Justify
Expands text to align on both the left and right margins. Justify applies only to text that expands
the length of the message.

Unordered List
Creates a bulleted list.

Ordered List
Creates a list that is ordered with letters or numbers of your choice.

Indent Less
Shifts text margin to the left.

Indent More
Shifts the text margin to the right.

Blockquote
Indents both margins of the text.

Font Menu

Font
Applies a specific font to the text.

Size
Applies a specific size to the text.

Color
Changes the color of the text or the background shading of the text.

Superscript
Shrinks text to a superscript size.

Subscript
Shrinks text to a subscript size.

Strikethrough
Applies strikethrough style to the text.

Remove Formatting
Returns the text to its plain default.

Find / Replace
Searches for keywords that you type and can replace them with another keyword.

Full Screen
Toggles between expanding and contracting the message window within the full size of the browser
window.

Settings

Word Count
Displays the number of words and characters in the message and the text that you have
highlighted.

Spell Check
Underlines possibly misspelled words in the message with a red squiggly.
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Capitalization
Auto-capitalizes the first word in a sentence.

Help
Displays keyboard shortcuts, accessibility instructions, markdown formatting guidance, and an
about the text editor.

Attachment
Include one or more files (limit of 50MB) with the e-mail message. Users can also retrieve the
attachments from their Notifications page.

System variables
System variables can be used as placeholders in all message types, hold notices, and hold notice
templates.

Parent topic: Managing legal matters
End of change

Requesting matter data

A key step in the legal matter management process is identifying, finding, and preserving all data that is
relevant to the legal matter. Legal users with Data Requests privileges can use StoredIQ for Legal to complete
the tasks of identifying, finding, and preserving data that is relevant to the matter by creating requests.

About this task

In StoredIQ for Legal, you can create a data box to request data that might be relevant to a matter. A data box
is a container for a specific request for data within a matter. A data box can contain information such as
status, identifying information (name, description), and the current artifacts that are associated with the data
box request. The data box serves as the object for handling both submitting requests to a IBM® StoredIQ Data
User, and reviewing responses. The data box type (identification, collection, export) helps you to quickly
determine the next action you might take on the request.

Requirement: You must have a Data Ops user with Data Requests privileges to assign the data box to (see
Assigning and managing user roles for details).
The types of data boxes and the actions you can complete on each type is as follows:

Table 1. Data box type and applicable actions
Data Box Type Actions that you can complete

Identification data box Revise
Refresh
Create Export Data Box
Create Collection Data Box
Create Data Report, Term Hit Report, CSV
Complete
Delete

Collection data box Refine
Create Export Data Box
Create Data Report, Term Hit Report, CSV
Complete

Export data box Create Data Report, Term Hit Report, CSV
Complete
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Data box statuses might change based on actions that are selected by the legal user or based on responses to
requests that are being delivered. Data boxes can have the following statuses:

Status Description
Draft The data box is not yet published and can be deleted. You can delete data boxes that are

only in draft status and only identification data boxes can be in the draft status.
Pending The status of the data box immediately after it is created and published. Also, the status of

the data box during refresh. You can click Cancel to abort the request and return it back to
Draft status.

Open The data expert fulfilled the request and you can start working with the data box contents,
such as refresh, investigate, verify, validate, or close.

Close The work that is related to the box is complete.
Start of

change
Rejected

End of
change

Start of changeThe data expert did not fulfill the request and returned it back to the legal
user. End of change

Transmission
Error

The request might not be delivered because the IBM StoredIQ server was not available.
StoredIQ for Legal automatically retries to deliver the request. If the transmission error
status does not change, contact your system administrator.

The flow of the request process in StoredIQ for Legal generally goes in the following order:

1. Identify matter relevant data by creating an identification data box.
2. Ensure that matter relevant data cannot be deleted or modified by transitioning the identification data

box to a collection box.
3. Review and refine the collected data.
4. Request to export the data by transitioning a collection data box to an export data box.

Creating a matter data request
Identifying data is the first step in the e-discovery process, and to begin that process, you create a
request. In StoredIQ for Legal, legal users with Data Requests privileges create a request by creating an
identification data box, which serves as a container for identifying, collecting, and exporting matter-
relevant data.
Managing and modifying data box requests
You might have many requests that you must manage. To help manage requests, a legal user with Data
Requests privileges can go to the Data Box overview page.
Closing a request
When a request is fulfilled and no additional work needs to be done with a request, a legal user with
Data Requests privileges can close the request.
Deleting a request
A legal user with Data Requests privileges can delete requests that are in draft state.

Parent topic: Managing legal matters

Creating a matter data request

Identifying data is the first step in the e-discovery process, and to begin that process, you create a request. In
StoredIQ for Legal, legal users with Data Requests privileges create a request by creating an identification
data box, which serves as a container for identifying, collecting, and exporting matter-relevant data.

Before you begin
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Before you can create an identification data box, a matter must be created. You create data boxes only within
the context of a matter. Also, you must have a Data Ops user with Data Requests privileges to assign the new
data box to (see Assigning and managing user roles for details).

About this task

Matter data identification is based on key scoping condition information such as data type, date range,
custodian, and Matter. When you create an identification box, you define the information scoping conditions.

An identification data box is the only type of box that you can create in StoredIQ for Legal. An identification
data box can be transitioned to a collection and export data box.

Procedure

To create an identification data box:

1. In the matter dashboard, click the matter for which you want to create a request.
2. Go to the Data Box section and click New Data Box.
3. In the Create Data Box window, enter a name for the request. You can also enter a description, which is

optional.
4. Click Create.
5. In the Request Criteria window, specify the required information.

Table 1. Identification data box criteria
Field Description

Locale The type of data source, where the data is located. You must select at least 1 locale. The
options include fileshares, email, desktops, content repository, and collaboration.

Date The start and end date range for the data. If you do not specify a date, the request spans all
possible dates.

Type The types of data, such as email messages, word-processing documents. The Type field is
required.

Search
Terms

Litigation terms on which to search.

Notes Instructional information for the data box expert. The notes field has a limit of 2,000
characters.

6. Click Custodians, and select one or more custodians from the list.
7. After you specify the criteria and add custodians, click Request to send the request to the IT group. You

can also discard your changes or save the data box as a draft.

Results

The request appears in the Data Box section within the matter it applies to. The initial status for the data box
is pending, and changes to open when the request is fulfilled. If you want to abort the request and return it
back to Draft state, click Cancel.

Parent topic: Requesting matter data

Managing and modifying data box requests

You might have many requests that you must manage. To help manage requests, a legal user with Data
Requests privileges can go to the Data Box overview page.

About this task
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The Data Box overview page provides a high-level visual representation of the requests for a matter, such as
the total number of requests, request status, and date request history. In addition, you see a request
summary that provides the status, the number of associated files and their size, modified date, and the
number of custodians that are associated with the request.

For Data Boxes in Open state, you can refresh, revise, and transition a request. You can also run detailed
reports for a request.

Procedure

To manage and modify a request:

1. Log in to the IBM® StoredIQ for Legal web client as a user with Data Requests privileges and click
Matters.

2. In the matters dashboard, click the matter for which you want to manage or modify a request.
3. Go to the Data Box section.
4. To see details for a request, click the request to open it. The request details are displayed, which

include a visual representation of the data and a list of the first 100 files that are associated with the
request. You can view a bar chart or treemap of the request data.

5. To revise a request:
a. Click the request, and then click Start of changeActions > Revise End of change.
b. Select Refine existing box or Expand box, and then specify the request criteria.
c. When you are done specifying the criteria, click Create Request.

When you revise a box, a new request is created.
6. To refresh a request, hover over the ellipses (...) next to the request in Open state and click Refresh.
7. Run a report for the request.

a. Open the request and click Start of changeActions > Report > Run Reports End of change.
b. Select which reports to generate and click Run Reports.

When the report is generated, a notification Reports available is displayed, and New is displayed
next to the Report menu.

8. View a report for the request.
a. Open the request and click Start of changeActions > Report > View Reports End of change.
b. Click the download icon of the report and save the file.

9. To transition a request, click the request to open it, and then click Start of changeActions >
Transition End of change. You can select to transition the box to Collect or Export state. A collection
box collects data for preservation when it is approved. An export box retains specific data when it is
approved for export.

Refining or expanding the scope of a request
A legal user with Data Requests privileges can transition the data that is in a collection data box by
refining, constraining the source data or by expanding the scope of the request. When you refine or
expand a data box, a new box is created. If you expand the scope of the request, the new data box is
restarted.
Refreshing matter data
A legal user with Data Requests privileges can refresh matter data for requests that are in Open state
only.
Running reports for matter data
A legal user with Data Requests privileges can run reports for matter data for requests that are in Open
state.
Requesting to preserve data for a matter
In StoredIQ for Legal, a legal user with Data Requests privileges can transition an identification data
box to a collection or export data box to request that data related to a matter be preserved.
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Requesting to export data for a matter
When a request for data is fulfilled, a legal user with Data Requests privileges can choose to request
that the data is exported by transitioning a data box to an export data box. An export box retains
specific data when it is approved for export.

Parent topic: Requesting matter data

Refining or expanding the scope of a request

A legal user with Data Requests privileges can transition the data that is in a collection data box by refining,
constraining the source data or by expanding the scope of the request. When you refine or expand a data box,
a new box is created. If you expand the scope of the request, the new data box is restarted.

About this task

When you refine a data box, you are adding extra scope conditions to the previously defined identification box
to refine or constrain the scope. When you expand a data box, you begin with the conditions specified in the
identification data box. However, you set a new scope by removing and changing some of the conditions.

When you refine or expand a data box, you are not transitioning what is in the data box. What was collected
stays collected and what was exported stays exported.

Procedure

To refine or expand a request:

1. In the matters dashboard, click the matter for which you want to refresh the data box.
2. Go to the Data Box section.
3. To refine a request:

a. Click the request to open it, and then click Start of changeActions > Revise End of change.
b. Select Refine existing box, and then specify the request criteria.
c. When you are done specifying the criteria, click Create Request.

You can also refine a data box by using the data map to specify the currently selected slice as the new
scope.

A new data box is created.
4. To expand a request:

a. Click the request to open it, and then click Start of changeActions > Revise End of change.
b. Select Expand box, and then modify the request criteria.
c. When you are done modifying the criteria, click Create Request.

Parent topic: Managing and modifying data box requests

Refreshing matter data

A legal user with Data Requests privileges can refresh matter data for requests that are in Open state only.

Procedure

To refresh a data box:
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1. In the matters dashboard, click the matter for which you want to refresh the data box.
2. Go to the Data Box section.
3. In the data box listing page, hover over the ellipses (...) next to the request in Open state that you want

to refresh, and click Start of changeActions > Refresh End of change.

Results

As a result, a new child request is created with a Pending status. The child request appears and the original
request in Open state is not visible.

What to do next

Alternatively, you can also refresh matter data by clicking Start of changeActions > Refresh End of change
in the Data Box Details window.

Parent topic: Managing and modifying data box requests

Running reports for matter data

A legal user with Data Requests privileges can run reports for matter data for requests that are in Open state.

About this task

You can generate the following reports for a data box:

CSV Infoset Data Object Export
Data Topology Report
Data Assessment Report
Compliance Report
Overlay Hit Report
Duplication Summary Report
Term Hit Report
Content Collector Manifest File CSV Export
CSV All Audited Objects Export

Procedure

To run reports on a data box:

1. In the matters dashboard, click the matter for which you want to run reports.
2. Go to the Data Box section and from the list of data boxes, open the data box that you want to run the

report for.
3. Click Start of changeActions > Report > Run Reports End of change.
4. Select which reports to generate and click Run Reports.

Results

When the report is generated, a notification Reports available is displayed, and New is displayed next to
the Report menu. Click Start of changeActions > Report > View Reports End of change to download them.

Parent topic: Managing and modifying data box requests

Requesting to preserve data for a matter
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In StoredIQ for Legal, a legal user with Data Requests privileges can transition an identification data box to a
collection or export data box to request that data related to a matter be preserved.

Before you begin

Before you can transition an identification data box to a collection data box, you must verify and refine the
data in the identification data box.

Procedure

To transition an identification data box to a collection data box:

1. In the matter dashboard, open the matter for which you want to make a preservation request.
2. Go the Data Box section, and click the identification data box that you want to transition.
3. Revise, expand, or transition the data box:

To revise the data box, complete the following steps:
a. Click Start of changeActions > Revise End of change.
b. Select Refine existing box, and then specify the request criteria.
c. When you are done specifying the criteria, click Create Request. A new data box is

created.
To expand the data box, complete the following steps:

a. Click Start of changeActions > Revise End of change.
b. Select Expand box, and then modify the request criteria.
c. When you are done modifying the criteria, click Create Request. A new data box is

created.
To transition the data box to a collection box, complete the following steps:

a. Click Start of changeActions > Transition > Collect End of change.
b. In the Collection Request window, enter the information for where to store the data, and

then click Request.

Results

Your request is sent to the IT department for a data expert on the IBM® StoredIQ end to fulfill your request.
Parent topic: Managing and modifying data box requests

Requesting to export data for a matter

When a request for data is fulfilled, a legal user with Data Requests privileges can choose to request that the
data is exported by transitioning a data box to an export data box. An export box retains specific data when it
is approved for export.

Procedure

To transition a data box to an export data box:

1. In the matters dashboard, click the matter for which you want to transition the data box.
2. Go to the Data Box section and from the list of data boxes, click the data box that you want to

transition. You can transtition an identification or collection data box to an export data box.
3. From the menu, click Start of changeActions > Transition > Export End of change.
4. In the Export Request window, specify the following information:

Table 1. Export request information
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Attribute DescriptionAttribute Description
Target location A description that instructs the data expert where to place the exported data.
Export format The formats available.
Email format The output format for emails.
DocID prefix The prefix for the DOCID. If a DocID prefix is not specified, the matter name is used.

5. Click Request.

Parent topic: Managing and modifying data box requests

Closing a request

When a request is fulfilled and no additional work needs to be done with a request, a legal user with Data
Requests privileges can close the request.

Procedure

To close a request:

1. In the Matters dashboard, click the matter for which you want to close the request.
2. Go to the Data Box section and in the list of data boxes, click the Close option next to the data box that

you want to close. The data box must be in Open state for you to close it. You might need to associate
an information set with it and complete it to move it to Open state.

Parent topic: Requesting matter data

Deleting a request

A legal user with Data Requests privileges can delete requests that are in draft state.

Procedure

To delete a request, you can hover over the icon of the data box in draft state and toggle the icon to delete.
Alternatively, you can complete the following steps:

1. In the matters dashboard, click the matter for which you want to delete a request.
2. Go to the Data Box section and from the list of data boxes, click a request that is in draft state to open

it. The Request Criteria window is displayed.
3. Click Delete Draft from the menu to delete the request.

Parent topic: Requesting matter data

Legal matter reports

To help paralegals and attorneys manage legal matters, StoredIQ for Legal provides the Global Custodians
and Matter Data reports (in the form of CSV files). The reports are in the Reports tab in the StoredIQ for Legal
web client.

Global Custodians reports
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The Global Custodians report lists the people who were identified as custodians in a matter across all matters.
The report includes the custodian information, the name of the matter that the custodian is associated with,
and various details about the notices that are associated with a custodian.

Start of changeTo access these reports, log in as a user with the View Notices privilege, click Reports, and
click Global Custodian Reports. End of change

The system generates a daily Global Custodians report (in the form of a CSV file) that provides metrics for
custodian statuses for Initial Notices and the initial follow-up. When a Reminder is sent, it becomes the new
notice and all previous recorded metrics reset. The Notice Details and Global Custodian Report contain the
responses recorded for the current notice only.

Reports are saved for 30 days before they are automatically deleted. You can filter the reports by date, and by
specifying the date range on the page.

The file encoding for the report must be set to UTF-8 to view the Globalization Verification Test (GVT)
characters in the report.

Start of change

Matter Data reports

The Matter Data reports provide you with details about the notices and data requests for a matter in a report
format.

To access these reports, log in as a user with the View Data Requests privilege, click Reports, and click Matter
Data Reports.

Click Run Report to generate them for a matter. You can request the following types of reports to be
generated:

Notices As Sent Report
Lists all hold notices that have been published (along with reproductions of the notices themselves),
and lists the notices' recipients.

Matter List Report
Lists all users who have been declared to be in the scope of the matter. Lists holds, interviews, and
boxes (along with their names).

Audit Report
Lists the audit record history for the matter and its notices, including users and their actions.

When you receive a pop-up notification that a new report is done generating, or if you see a dot next to the
Reports, click View Reports to list them. You can filter the reports by date, and by type. You can also click the
download button to download a report as a CSV file.

End of change
Parent topic: Managing legal matters

Start of change

Glossary

The glossary explains terms that are used in this information. Terms that are shown in italics are defined
elsewhere in this glossary. To view glossaries for other IBM® products, go to
http://www.ibm.com/software/globalization/terminology/.
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A

alert
A notification, by email, that one or more follow-up actions are required.
A visual notification next to an input field.

C

collection

After the scope of a matter is determined, relevant documents must be gathered. The legal team
usually works with the IT team to locate and collect relevant documents from the data sources, but the
legal team can also enlist individual custodians. At the end of the collection process, the documents
are presented to the opposing legal team.

See also data box.

conditional question
An additional question that is asked based on the answer that was given in a previous question.

For example, if a recipient answers the question "Do you know of another person who has knowledge of
this legal matter?" with "Yes", a conditional question might be "What is the name of this person?".

custodian
A person who owns or maintains information that might be pertinent to a legal matter. Custodians are
legally obligated to preserve information that is on hold. Custodians are typically expected to
acknowledge receipt of a hold notice and expected to agree to preserve the relevant information until
either the information is collected from the data source or the custodian is released from the hold.

D

data box
A container for a specific request for data within a matter. It can contain information such as status,
identifying information, and the current artifacts that are associated with the data-box request. The
data box serves as the object for submitting requests to a StoredIQ for Legal user, and for reviewing
responses.

H

hold
Also called legal hold. The process that an organization uses to preserve information that is potentially
relevant to a matter. A method of stopping the normal disposition of data, documents, or other relevant
information, usually because of court cases or investigations.

hold notice
A formal notice, typically in an email, that instructs custodians to preserve relevant documents and
information, and suspend normal retention and destruction schedules. Hold notices provide details
about the nature of a matter and the information that must be preserved.

The custodians who receive a hold notice are considered on hold until a release disobliges them of the
preservation requirement.

See also initial notice and release.

I
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initial interview
The first interview that specific custodians receive regarding a legal matter. Depending on how the
interview is configured, the initial interview can be followed by the following items:

Follow-up messages, which are sent to the recipients of the interview who have not yet
responded. If a recipient continues to not respond, the manager can be informed by an email.
Recurring interviews, which are sent to the recipients of the initial interview. Recurring
interviews are used to determine whether any of the information that was returned for a prior
interview, has changed in the meantime.
Follow-up messages on each recurring interview, which are sent to the recipients of the
interview who have not yet responded. If a recipient continues to not respond, the manager can
be informed by an email.

Each time an interview or a follow-up message is sent out, the recipients receive an email with a link to
the interview.

initial notice
The first hold notice that specific custodians receive for a particular preservation obligation. Depending
on how the hold notice is configured, the initial notice can be followed by the following items:

Follow-up messages on the initial notice, which are sent to custodians who have not yet
confirmed the preservation. If a custodian continues to not respond, the manager can be
informed by an email.
Reminder notices, which inform the custodians that the obligation is ongoing.
Follow-up messages on the reminder notice, which are sent to custodians who have not yet
confirmed the preservation. If a custodian continues to not respond, the manager can be
informed by an email.

Each time a hold notice or a follow-up message is sent out, the custodians receive an email. The email
can contain a confirmation link.

interview
A questionnaire that is sent to more than one custodian to obtain information that pertains to legal
matters. See also initial interview.

L

legal hold
See hold.

M

matter
An actual or potential court case or another legal action; an issue under consideration in a lawsuit. It is
the broadest organizational entity for legal activities. Examples of matter include intellectual property
disputes, malpractice claims, and workplace discrimination allegations.

When a matter arises, the legal team must step in quickly to prepare for discovery. Any document that
might include information about the matter that is in the possession of the enterprise can be used as
evidence.

You might create a matter, for example, when there is a complaint by an adversary who is threatening a
lawsuit. To put a matter into action, you create holds, collections, and interviews that drive the
discovery process.
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R

recurring interview
See initial interview.

release
The removal of a preservation requirement, usually upon the termination of the matter at issue.

reminder notice
See initial notice.

role

A designation, such as attorney or system administrator, that represents a set of permissions.
Individual users are given roles to grant them access to particular objects and functions.

S

system variable

A context-sensitive variable that can be added to a hold notice or interview. Such a placeholder
represents dynamic data, such as the name of the interview recipient or the name of the attorney for
the matter. When the system sends the notice or interview, it replaces the placeholder with an actual
value.

Some placeholders define how a recipient can respond to a hold notice or can access an interview. For
example, by adding the {Confirmation Link} variable to a hold notice, the recipient respond to this hold
notice by clicking the confirmation button.

user

A person who is assigned a role, and thus can view and manage basic information in the system.

End of change
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